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Resumen Ejecutivo 

El acero es un material estructural por excelencia debido a la gran ductilidad que ofrece, y su 

excelente comportamiento bajo cargas de tracción y flexión. Tal es su popularidad, que se 

utiliza en diferentes tipos de mega construcciones en Chile. Sin embargo, el acero también 

se puede agrietar después de una cantidad importante de ciclos de cargas estáticas y 

dinámicas. Estas grietas pueden ser causantes de una falla estructural posterior, y al ser parte 

de construcciones importantes traen consigo una pérdida económica considerable. Durante 

los últimos años, la Ingeniería ha estudiado con determinación el concepto de tolerancia al 

daño. Éste indica que, al aparecer una grieta o alguna imperfección en una estructura 

determinada, no necesariamente significa que ésta fallará prontamente, sino que propone 

realizar un estudio para evaluar la propagación de esta en el tiempo según la solicitación de 

carga que reciba.  

En este trabajo, se seleccionaron dos tipos de vigas de acero comerciales, donde con pequeñas 

intervenciones a su geometría e induciendo una grieta en su centro, se logró estudiar la 

propagación de dicha grieta, a través de una prensa hidráulica ubicada en el laboratorio de 

Ingeniería de la Universidad de Talca. Al mismo tiempo, las dimensiones geométricas y 

propiedades constitutivas de las vigas ensayadas fueron ingresadas en el software de 

elementos finitos Salomé-Meca, buscando comparar los comportamientos experimentales 

con los de la simulación, y verificar si este es un método válido para ser utilizado y estudiar 

la tolerancia al daño en estructuras. Finalmente, los ensayos realizados en el laboratorio 

indicaron una propagación de grieta y una nueva ubicación del frente de grieta, mientras que 

en la simulación se obtuvo una propagación de grieta precisa y la ubicación del frente de 

grieta milimétricamente similar. Esto indica que se verifica el ensayo experimental con 

respecto a la simulación computacional, validando este método para estudiar la tolerancia al 

daño estructural.  

 

Palabras claves:  acero, dog-bone, ensayo experimental, simulación computacional, Salomé-

Meca, XFEM, tolerancia al daño, grieta, propagación, frente de grieta. 
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Abstract 

Steel is by excellence a structural material, thanks to the great ductility it offers, as well as 

its outstanding performance under traction and flexure loads. Its popularity is such, that it is 

used in a wide range of large-scale constructions in Chile. Notwithstanding, steel is known 

to fissure after a considerable number of static and dynamic load cycles, leading to larger 

fissures that can ultimately cause structural failure. Taking into account that typically steel is 

used in projects of large proportions, the economic loss that accompanies this failure is 

usually substantial. Over recent years, there has been a focus in the field of engineering on 

damage tolerance in structures. This is a concept that explains that while fissures and 

imperfections may appear in a certain structure, not necessarily does this mean that there is 

imminent danger of failure or collapse. Instead, a closer study is required of the fissures and 

their propagation over the course of time, depending on the load demands the structure is 

subject to.  

In this thesis, two types of commercially available steel beams were selected and modified 

geometrically, by generating a small, fissure-like cut in their centers. These beams were then 

tested in a hydraulic press located in the laboratory of the University of Talca, in order to 

study de propagation of the induced fissures. Working in parallel, the beams were modeled 

with geometric precision in the finite element software program called Salomé-Meca, taking 

care to conserve their physical characteristics in the program’s design parameters. The 

objective was to compare the experimental behavior with that of the beams tested in 

laboratory trials, and thus verify the validity of the simulation results, for future study of 

damage tolerance. Finally, the tests conducted in the university laboratory resulted in a fissure 

growth and a new crack front in test beams, while the program simulation obtained a precise 

fissure and a crack front location that was millimetrically similar. This outcome, shows that 

the simulation is in keeping with the experimental laboratory results, proving that it is a 

valuable method for studying tolerance to damage in structures.  

 

Key words: steel, beam, experimental trial, program simulation, Salomé-Meca, finite element 

method, damage tolerance, fissure, propagation, crack front 
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CAPÍTULO 1: INTRODUCCIÓN Y OBJETIVOS 

1.1 Introducción 

En estructuras es muy común encontrar diversos tipos de fallas, si bien es sencillo 

identificarlas, lo complejo es poder comprender el origen de estas, su comportamiento en el 

tiempo y las posibles dificultades que puede traer al proyecto. Una de las fallas más comunes 

e importantes de analizar son las grietas. 

El análisis de propagación de grietas consiste en un proceso iterativo computacional, 

compuesto por varias etapas que van mostrando el avance de esta para cada caso de carga 

hasta llegar a la convergencia. El análisis clásico consiste en la partición de la malla de 

análisis de forma manual cada vez que cambia de dimensión la grieta en el software 

computacional. 

Los softwares computacionales resuelven los problemas de mecánica de solidos mediante los 

métodos de elementos finitos, resolviendo ecuaciones diferenciales mediante la forma débil 

de diversos problemas de física, matemática e ingeniería.  

En el presente proyecto se inducirá una grieta en una viga de acero con forma de dog-bone, 

para luego ensayarla en el laboratorio con maquinaria de flexión. Posteriormente se 

verificarán los resultados obtenidos en el laboratorio con los resultados de la propagación de 

grietas realizados en el software computacional. 

Para realizar los cálculos computacionales se utilizará el software de licencia libre Salomé-

Meca. Para lograr la simulación de la propagación de las grietas se utilizará la extensión de 

los métodos de elementos finitos de este programa computacional llamado XFEM, la cual 

consiste en utilizar funciones de forma, no necesitando un corte del mallado extra sobre las 

mismas.  

Este análisis posee una importante relevancia para diferentes clases de industria, como por 

ejemplo la minera, la ferroviaria y las obras civiles. Realizar una buena simulación y 

verificación de una grieta entrega resultados óptimos para poder evitar la demolición de la 

estructura en cuestión, es decir, evitar la paralización de dicho sector industrial y así lograr 

evitar pérdidas de dineros.  
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1.2 Objetivo General 

Verificar el comportamiento de propagación de grieta de una viga de acero en software 

computacional con respecto al ensayo en laboratorio.  

1.3 Objetivos Específicos 

• Realizar un ensayo experimental a flexión en una viga de acero tipo dog-bone, con 

una grieta inducida. 

• Realizar simulaciones computacionales de los modelos dog-bone, utilizando la 

metodología X-FEM en el software Salomé-Meca.  

• Calibrar los resultados de la simulación computacional para disminuir la diferencia 

de la propagación de la grieta con respecto a la experimentación.  
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CAPÍTULO 2: MARCO TEÓRICO 

 

Una de las principales causas de fallas en elementos estructurales es la fatiga [30]. Por tanto, 

se trata de un fenómeno que afecta todo tipo de edificación, lo que requiere una respuesta o 

solución ingenieril. Existen dos formas de resolver este dilema: la demolición y 

reconstrucción, o el análisis de la grieta y su comportamiento, a fin de evitar la necesidad de 

una intervención.  

Esta última alternativa incurre en la optimización de recursos con el objetivo de eludir el 

impacto económico y logístico que significa una demolición, cualquiera sea su envergadura. 

Por otro lado, la utilización de software computacional basado en elementos finitos cobra 

una vital importancia para poder tomar la decisión de demoler o reconstruir. Un análisis de 

elementos finitos se realiza habitualmente para prever el comportamiento mecánico de una 

estructura. Posteriormente se verifica dicho análisis con respecto a la normativa vigente en 

cada país. 

2.1.Introducción al fenómeno de fatiga 

El proceso de fallo producto de la fatiga se fundamenta en la disminución de resistencia en 

estructuras mediante ciclos de carga de duraciones extendidas. Son diversos los elementos 

que se ven afectados por este fenómeno, por ejemplo, edificios, puentes, maquinaria rotativa, 

ruedas de ferrocarril, estructuras mineras, etc. 

 

La fatiga estructural se origina con solicitaciones de carácter cíclico que fluctúan entre la 

tracción y la compresión.  La acumulación de todas las tensiones aplicadas en la estructura 

en su vida útil es lo que se llama resistencia a la fatiga. Es importante mencionar que los 

datos para diseñar son producidos en ensayos a carga constante. Además, en estructuras 

reales las cargas recibidas son aleatoriamente dinámicas por lo que constantemente cambia 

la amplitud de la carga y se puede evidenciar en el historial de tensiones del elemento 

estructural.  

 

La historia de tensiones es una representación histórica de la aplicación de cargas en un 

determinado elemento. Con este registro se busca responder conservadoramente a la totalidad 

de cargas, ya sean estáticas y/o dinámicas. 
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Ilustración 1 Historial de tensiones (adaptado de [31]). 

En muchas ocasiones, la medición de fatiga se obtiene de la diferencia del factor de 

intensidad de tensiones, el cual está compuesto por las tensiones aplicadas y el respectivo 

dimensionado geométrico de la grieta [16]. Este factor se representa por la siguiente 

ecuación:  

∆𝑘 = 𝐾𝑚á𝑥 − 𝐾𝑚𝑖𝑛                                          (Ec 1) 

Donde:  

• ∆𝑘: Factor de intensidad de tensiones. 

• 𝐾𝑚á𝑥: Valor máximo de factor de intensidad de tensiones de un ciclo. 

• 𝐾𝑚𝑖𝑛: Valor mínimo de factor de intensidad de tensiones de un ciclo. 

El factor de intensidad de tensiones (FIT) determina el estado tensional en el contorno del 

extremo de la fisura, por lo que se ha determinado una gran cantidad de técnicas de estudio. 

En la actualidad, el medio analítico ha sido desplazado por lo que es el análisis numérico. 

Se consideran tres métodos para encontrar el FIT, dependiendo de la calidad de este y el 

tiempo de empleo para el análisis. 

• Manuales y compendios, como ejemplo Murakami [9]. 

• Técnicas simplificadas, se ejemplifica en el texto de Aliabadi y Rooke [10]. 

• Métodos más sofisticados con soluciones numéricas. 

Las tensiones de carga se manifiestan de forma cíclica y aleatoria y son representadas a través 

de ondas (Ilustración 1). Debido a ello, la recopilación de todos estos registros se realiza 

mediante el principio de superposición de ondas [18]. La variabilidad de las cargas puede 

suceder por cambios de magnitud, cambios en las condiciones de borde, cambios de dirección 

de aplicación de la carga y variables naturales, entre otras. Las tensiones de carga poseen 

amplitud variable en el tiempo, por lo que se opta por facilitar su estudio, aplicando el 

concepto de conteo de ciclos. Éste es un método que modifica la naturaleza variable de la 

amplitud de ondas de las tensiones de carga en amplitud constante, sin modificar los efectos 
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de daño que generan [1]. El conteo de ciclos posee dos formas de realizarse, las cuales se 

definen en función de si consideran el proceso previo a la fractura o no: 

Método que no considera proceso previo a la fractura: Este método es idealizado, puesto que 

no considera la fase de plastificación del material, es decir, el comportamiento no lineal entre 

tensión y deformación [14]. 

Método que si considera proceso previo a la fractura: Este método considera la fase no lineal 

del material, es decir, el comportamiento entre la tensión y la deformación [19]. Es por esto 

por lo que en la actualidad es el que más uso tiene. 

 

 

 

 

 

 

 

 

 

 

 

En la Ilustración 2 se puede apreciar el comportamiento plástico de un material con respecto 

al tiempo. Realizando el seguimiento, se aprecia una carga tensional desde el punto a al punto 

b, por este suceso existe una deformación desde el punto a al b, entre el punto b y c se genera 

una descarga tensional, con esto se invierte el sentido de la deformación. Cuando se vuelve 

a tensionar el material se carga desde c hasta b para luego alcanzar a d, mientras que si se 

visualiza solo el gráfico de deformación se ve que es directo el movimiento, continuando la 

deformación desde c hasta d. Esta diferencia se fundamenta en que el material recuerda su 

historial de carga tensional y utiliza ese mismo procedimiento. El gráfico tensión-

desplazamiento con respecto al tiempo, es un fenómeno llamado histéresis. 

De esta forma, considerando las FIT y lo anterior además de lo indicado por el IIW, los 

estados límites de fatiga se pueden identificar mediante: 

• El uso de Curvas de Wöhler y principio de acumulación de daño de Palmgreen-

Miner.  

• La mecánica de fractura, propagación y resistencia a la fatiga. 

Ilustración 2 Comparación de gráficos deformación con respecto al tiempo y tensión-deformación con respecto al tiempo 

[14]. 
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2.1.1. Resistencia a fatiga basada en curvas de Wöhler y Principio de acumulación de 

daño de Palmgreen-Miner 

El estudio basado en las curvas de Wöhler, también conocidas como curvas de S-N, consta 

de la realización de un análisis de comparación de los ciclos de cargas aplicados a una 

estructura versus la cantidad de ciclos que resiste esta misma. El fallo por fatiga se considera 

en la posición más agrietada por la acción de la solicitación. Para obtener las curvas de Wöhler 

se utiliza la siguiente expresión: 

      𝑁 =
𝐶

∆𝜎𝑚
                                              (Ec 2) 

Donde:  

• N: Equivale al número de ciclos. 

• C: Constante que depende del tipo de curva. 

• m: valor de la pendiente de la curva. (Puede tomar diversos valores según ciclos 

experimentados). 

• ∆𝜎: Representa el rango de tensiones. 

 

Todos los valores generados en estas curvas corresponden a la supervivencia de los elementos 

con una confianza del 95%. No obstante, es fundamental que el rango de tensiones nominales 

se encuentre dentro de las propiedades elásticas del material en cuestión. Es sabido que existe 

una estandarización del límite máximo de las curvas de Wöhler que es representado por la 

curva FAT160, sin embargo, puede ampliarse según lo estipulado en el laboratorio, 

asimismo, se realizan pruebas de tensiones normales y cizallas [3]. 

 

 

 

 

 

 

 

 

 

 

Ilustración 3 Ejemplificación Curvas de Wöhler [39]. 

La regla de Palmgreen-Miner, también conocida como regla de acumulación de daño, nace 

de la necesidad de realizar una mejora al método de curvas de Wöhler. Las Curvas S-N solo 

pueden ser aplicadas para cargas cíclicas constantes, y en la realidad, las estructuras a lo largo 

de su vida útil reciben solicitaciones variables. Por otra parte, ésta es una regla de carácter 

lineal. 
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Para realizar la estimación de la vida útil con respecto a la resistencia a la fatiga se realiza un 

conteo de ciclos con cargas distintas y variables. El principal objetivo es estimar cuántos 

incrementos de carga se pueden aplicar antes que aparezca el fenómeno. Se debe tener en 

cuenta que: 

• Los tipos de cargas se deben considerar como un espectro de amplitudes de sus ciclos 

de carga, es decir, generar un registro para distintas variaciones de solicitaciones. 

• La utilización de curvas de Wöhler es compatible con el tipo de tensión utilizada.  

El fallo se produce en un estado de Carga 𝑆𝑖 con un número de ciclos 𝑁𝑖. Al evaluar 𝑛𝑖 y este 

ser menor a 𝑁𝑖 se conoce el concepto de fracción de daño [20]. 

                                                   𝐷1 + 𝐷2 + 𝐷3+. . +𝐷𝑛 ≥ 1                                           (𝐸𝑐 3) 

                                                                 𝐷𝑖 =
𝑛𝑖

𝑁𝑖 
                                                             (𝐸𝑐 4)    

Donde: 

• D= fracción de daño. 

• 𝑁𝑖: Número de daño total. 

• 𝑛𝑖: Número de daño del ciclo.  

Remplazando (Ec 4) en (Ec 3) se tiene que para que exista un fallo en el material la sumatoria 

de fracciones de daño debe ser igual o superior a 1. (Ilustración 4). 

                                                    
𝑛1

𝑁1
+

𝑛2

𝑁2
+

𝑛3

𝑁3
+. . +

𝑛𝑛

𝑁𝑛
≥ 1                                         (𝐸𝑐 5) 

Finalmente queda: 

                                                                           ∑
𝑛1

𝑁1
≥ 1                                                      (𝐸𝑐 6) 

Esta regla no mantiene el orden de los sucesos de ocurrencia de las fracciones de daño, sino 

que lo ordena según la magnitud de este [20].  
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2.1.2. Resistencia a la fatiga en mecánica de fractura 

La norma inglesa BS7910 [4] consiste en una guía que evalúa imperfecciones en estructuras 

metálicas. Se basa en la tolerancia del comportamiento frágil y dúctil del acero considerando 

la conducta de las solicitaciones encargadas al modelo. Con esta metodología se logra 

calcular la longitud máxima de la grieta de rotura considerando las propiedades del material.  

Por otro lado, investigadores aseguran que la longitud de la grieta es equivalente al espesor 

de la placa estudiada [5][6]. Sin embargo, otros científicos creen que el límite de la grieta es 

la mitad del espesor [7].  

En mecánica de la fractura, este método evalúa la resistencia a la fatiga con o sin problemas 

anteriores y se basa principalmente en la relación entre velocidad de propagación de la grieta 

y el estado tensional al que se somete el elemento.  

La propagación de la grieta consiste en las siguientes etapas: 

Iniciación: Puede comenzar en cualquier punto del material, pero usualmente las grietas se 

generan en los lugares donde se concentran las tensiones y en la superficie exterior. Para este 

punto, existen tratamientos de reparación de las grietas superficiales que prolongan la vida 

útil del elemento.   

Crecimiento: La grieta tiende a desarrollarse de forma perpendicular a la aplicación de la 

tensión, lo cual se separa en dos etapas: 

Crecimiento microscópico: No hace relación a la mecánica de fracturas, pero si se aplican 

leyes elastoplásticas distintas, además, el crecimiento es a nivel de grano del material. 

Crecimiento macroscópico: Se tiene un crecimiento rápido, y se aplica la ley de Paris: 

Ilustración 4 Variación No Lineal de fracción de daño (adaptado de [20].) 
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𝑑𝑎

𝑑𝑁
= 𝐶∆𝐾𝑚                                                        (Ec 7) 

Donde: 

• ∆𝐾= Rango intensidad de tensiones. 

• 
𝑑𝑎

𝑑𝑁
 = Tasa de crecimiento de longitud de la grieta. 

Las demás variables son constantes que dependen del tipo de material.  

 

Ilustración 5 Curva de propagación de una grieta [32].  

Rotura: Sucede cuando el tamaño de la sección no logra resistir la carga del ciclo y el sector 

restante se rompe.  

 

 

 

 

 

 

 

 

Ilustración 6 Fases de la rotura de una grieta [27]. 
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Con respecto a la evaluación de la grieta, de acuerdo con la teoría de mecánica de la fractura, 

la oposición a que suceda se relaciona directamente al factor de intensidad de tensiones ∆𝑘 y 

la relación entre la longitud de la fractura y la cantidad de ciclos 
𝑑𝐴

𝑑𝑁
. Se destacan dos periodos 

importantes dentro del suceso de la fractura. 

Periodo de iniciación: El periodo comprendido es desde que se supera el umbral ∆𝑘𝑡ℎ 

hasta el término del periodo microscópico. Desempeñan un papel importante las 

imperfecciones que tenga el material. Como el crecimiento es a nivel interno del 

grano, no se aplica la teoría de mecánica de la fractura. 

 

Periodo de desarrollo: Sucede desde el crecimiento macroscópico hasta la etapa de 

rotura dependiendo directamente de la resistencia del material. Por lo tanto, sí se 

aplica la teoría de mecánica de la fractura obteniéndose el número de ciclos de 

acuerdo con la ley de Paris [21]. 

Para estimar la resistencia a la fatiga de un material, la teoría de mecánica de la fractura es 

un modelo competente en la práctica. Se enfoca principalmente en dos principios [22]: 

Estimación del número de ciclos de carga para el colapso: Se analiza este aspecto 

para la predicción de durabilidad de la fatiga antes que alcance la rotura. Por lo 

mismo, se estima un límite de desarrollo para no poner en riesgo al elemento.  

 

Estimación de proceder de fisuras ya existentes: Se analiza este caso para estimar la 

durabilidad del servicio que presta el elemento dañado, prediciendo el 

comportamiento de la grieta en el tiempo.  

La evaluación del daño causado según la teoría de la mecánica de la fractura [23] se basa en 

la ley de Paris de integración simple. 

                                         
𝑑𝑎

𝑑𝑁
= 𝐶(∆𝐾)𝑚 = 𝐶(𝑆√𝜋𝑎𝐹(𝑎))𝑚, ∆𝐾 > ∆𝐾0                    (𝐸𝑐 8) 

                                                                 𝑁 =
1

𝐶
∫

𝑑𝑎

∆𝑆√𝜋𝑎𝐹(𝑎))𝑚
                                          (𝐸𝑐 9)

𝑎𝑐
𝑎0

 

Donde: 

• C y m: Parámetros dependientes del tipo de material [23]. 

• ∆𝐾: Incremento factor de intensidad de tensiones de la fisura. 

• 𝑎0: Profundidad inicial de la grieta. 

• 𝑎𝑐: Profundidad crítica de la grieta. 

• F(a): Función que depende de la geometría de la fisura. 

Se sugieren dos métodos para comparar la tasa de desarrollo 
𝑑𝑎

𝑑𝑁
 y el factor de intensidad de 

tensiones [23]. El primero trata de un gráfico lineal, mientras que la segunda alternativa es 

un gráfico bilineal. Este último busca la disminución gradual de la tasa de desarrollo. 
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Ilustración 7 Relación entre tasa de desarrollo y factor de intensidad de tensiones lineal [14]. 

 

Ilustración 8 Relación bilineal de tasa de desarrollo y factor de intensidad de tensiones [14]. 

Se postula el cálculo del tamaño máximo de la rotura de la grieta; éste depende de las 

propiedades del material (estado límite último, estado límite elástico,𝑘𝑚𝑎𝑡) [23]. 

𝐾𝑟 = (1 − 0.14𝐿𝑟
2) ∗ (0.3 + 0.7𝑒−0.65𝐿𝑟

6
), 𝐿𝑟 ≤ 𝐿𝑟,𝑚𝑎𝑥                 (𝐸𝑐 10) 

                                                  𝐾𝑟 = 0, 𝐿𝑟 > 𝐿𝑟,𝑚𝑎𝑥                                           (𝐸𝑐 11) 

Donde: 

• 𝐿𝑟: Largo de la grieta. 

• 𝐾𝑟: Tamaño máximo de la rotura. 
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• 𝐿𝑟,𝑚𝑎𝑥: Longitud máxima de la grieta. 

Según este criterio se alcanza la rotura del material cuando el tamaño de la grieta se encuentra 

fuera del rango definido por la fórmula anterior [23]. Los valores de los parámetros dependen 

de cada material. Los estados de carga son variables en el tiempo, este postulado posee el 

problema de que para cada estado de carga entrega un valor distinto de longitud de la fisura, 

por lo que es útil para cargas de tipo constante [23]. 

2.2.Solución Analítica para mecánica de la fractura 

Para solucionar analíticamente un caso de mecánica de la fractura se deben considerar 

ecuaciones diferenciales parciales en geometrías complejas [26]. En primera instancia se 

considera la evaluación de las propiedades del cuerpo, como su equilibrio de tensiones, sus 

propiedades constitutivas, su geometría. Posteriormente se adaptan estas condiciones a la 

grieta. 

Los problemas de mecánica de la fractura íntegramente presentan en su modelo lineal un 

comportamiento particular de deformaciones y tensiones. La mecánica teórica considera al 

cuerpo indeformable en estado de reposo y movimiento, pero esto no aplica en la práctica. 

Es importante comprender estos conceptos [24]: 

• Sólido Rígido: Se entiende como la invariación de la distancia entre dos moléculas 

cualquiera del material independiente del esfuerzo aplicado. Suponiendo que este 

principio se cumple, bastaría realizar los cálculos de reacciones para conocer el 

sistema de fuerzas participantes, por lo que no existiría peligro de agrietamientos y 

menos aún una rotura, claramente esto no sucede así en la práctica. 

 

• Sólido elástico: Se entiende como un sólido que al ser aplicado una carga se deforma 

y luego tiene la capacidad de volver a su estado anterior. Surge este concepto por la 

necesidad de estudiar los límites de carga que se le puede aplicar a un elemento o para 

realizar el dimensionado de un elemento con una carga determinada, sin correr el 

riesgo de que se fatigue. Se presume que se cumplen como característica la isotropía, 

homogeneidad y continuidad.  

 

• Isotropía: Consiste en comprender que las propiedades del cuerpo son equivalentes 

independientemente de la dirección donde se aplique una fuerza determinada. En 

otras palabras, la elasticidad es la misma para todas las direcciones del cuerpo.  

 

• Homogeneidad: Este concepto explica que el material posee la misma composición 

en todos los puntos del sólido. 

 

• Continuidad: Hace referencia a que no existen espacios entre las partículas generando 

interrupción en el material.  

• Sólido verdadero: Es un sólido que se considera deformable en todas sus direcciones, 

asumiendo la falta de isotropía, homogeneidad y continuidad. 
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Los conceptos de isotropía, homogeneidad y continuidad son microscópicamente utópicos, 

no se cumplen en los materiales ni naturales ni artificiales puesto que ninguno es perfecto. 

Sin embargo, se asumen como válidas para efectos de cálculo basados en la experiencia, ya 

que macroscópicamente sí cumplen esta hipótesis [24]. 

2.2.1. Desarrollo analítico de tensiones  

Se aplica un análisis de tensiones para resolver un problema mecánico en un sistema de 

equilibrio estático. Se asume que las fuerzas externas aplicadas que actúan en un cuerpo son 

deformables. Se realiza para evaluar el desempeño de las conexiones, elementos y 

deformaciones del cuerpo, a través de las reacciones, esfuerzos internos y deformaciones 

obtenidas.  

Para poder completar el equilibrio diferencial de tensiones se debe cumplir lo siguiente: 

 

∑𝐹𝐻𝑜𝑟𝑖𝑧𝑜𝑛𝑡𝑎𝑙𝑒𝑠 = 0                                               (𝐸𝑐 12) 

∑𝐹𝑉𝑒𝑟𝑡𝑖𝑐𝑎𝑙𝑒𝑠 = 0                                                    (𝐸𝑐 13) 

∑𝑀𝐶𝑒𝑛𝑡𝑟𝑜 =𝜏𝑥𝑦 = 𝜏𝑦𝑥                                          (𝐸𝑐 14) 

Para comprender el desarrollo de este análisis ver ilustración 9.  

 

 

 

 

 

 

 

 

 

∑𝐹𝐻𝑜𝑟𝑖𝑧 = −𝜎𝑥(𝑑𝑧 𝑑𝑦) + (
𝜕𝜎𝑥

𝜕𝑥
𝑑𝑥)𝑑𝑦𝑑𝑧 − 𝜏𝑦𝑥(𝑑𝑥𝑑𝑧) + (𝜏𝑦𝑥+

𝜕𝜏𝑦𝑥

𝜕𝑦
𝑑𝑦)𝑑𝑥𝑑𝑧 + 𝐹𝑋 = 0                              

                                                                                                              (Ec 15) 

Ilustración 9 Tensor de tensiones en dos dimensiones [25]. 
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Despejando términos semejantes: 

∑𝐹𝐻𝑜𝑟𝑖𝑧𝑜𝑛𝑡𝑎𝑙𝑒𝑠 =
𝜕𝜎𝑥
𝜕𝑥

+
𝜕𝜏𝑦𝑥

𝜕𝑦
+
𝐹𝑥
𝑑𝑉

= 0                           (𝐸𝑐 15) 

∑𝐹𝑉𝑒𝑟𝑡𝑖𝑐𝑎𝑙𝑒𝑠 = −𝜎𝑦(𝑑𝑧 𝑑𝑥) + (
𝜕𝜎𝑦

𝜕𝑦
𝑑𝑦)𝑑𝑥𝑑𝑧 − 𝜏𝑥𝑦(𝑑𝑥𝑑𝑧) + (𝜏𝑥𝑦+

𝜕𝜏𝑥𝑦

𝜕𝑥
𝑑𝑥)𝑑𝑦𝑑𝑧 + 𝐹𝑦 = 0 

                                                                                                                 (Ec 16).  

Despejando términos semejantes: 

∑𝐹𝑉𝑒𝑟𝑡𝑖𝑐𝑎𝑙𝑒𝑠 =
𝜕𝜎𝑦

𝜕𝑦
+
𝜕𝜏𝑥𝑦

𝜕𝑥
+
𝐹𝑦

𝑑𝑉
= 0                              (𝐸𝑐 16) 

∑𝑀𝐶𝑒𝑛𝑡𝑟𝑜 =0                                                                          (𝐸𝑐 17) 

Por simple inspección se obtiene que: 

∑𝑀𝐶𝑒𝑛𝑡𝑟𝑜 =𝜏𝑥𝑦 = 𝜏𝑦𝑥                                                           (𝐸𝑐 17) 

Donde:  

• 𝜎𝑥   : Tensión tangencial en el eje x.  

• 𝜎𝑦 : Tensión tangencial en el eje y. 

• 𝜏𝑥𝑦: Tensión de corte en eje y. 

• 𝜏𝑦𝑥: Tensión de corte en eje x. 

• 
𝐹𝑦

𝑑𝑉
: Fuerza de cuerpo en eje y. 

• 
𝐹𝑥

𝑑𝑉
: Fuerza de cuerpo en eje x. 

Por lo tanto, el equilibrio diferencial en dos ecuaciones queda representado por: 

∑𝐹𝐻𝑜𝑟𝑖𝑧𝑜𝑛𝑡𝑎𝑙𝑒𝑠 =
𝜕𝜎𝑥
𝜕𝑥

+
𝜕𝜏𝑦𝑥

𝜕𝑦
+
𝐹𝑥
𝑑𝑉

= 0                              (𝐸𝑐 15) 

∑𝐹𝑉𝑒𝑟𝑡𝑖𝑐𝑎𝑙𝑒𝑠 =
𝜕𝜎𝑦

𝜕𝑦
+
𝜕𝜏𝑥𝑦

𝜕𝑥
+
𝐹𝑦

𝑑𝑉
= 0                                  (𝐸𝑐 16) 

∑𝑀𝐶𝑒𝑛𝑡𝑟𝑜 =𝜏𝑥𝑦 = 𝜏𝑦𝑥                                                             (𝐸𝑐 17) 
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Ilustración 10 Componente de tensiones en 3D [29]. 

El mismo principio demostrado para el equilibrio diferencial en dos dimensiones se cumple 

para las tres dimensiones. Se deben considerar las siguientes ecuaciones: 

Obteniéndose:  

𝜕𝜎𝑥
𝜕𝑥

+
𝜕𝜏𝑦𝑥

𝜕𝑦
+
𝜕𝜏𝑧𝑥
𝜕𝑧

+
𝐹𝑥
𝑑𝑉

= 0                                      (𝐸𝑐 18) 

𝜕𝜏𝑥𝑦

𝜕𝑥
+
𝜕𝜎𝑦

𝜕𝑦
+
𝜕𝜏𝑧𝑦

𝜕𝑧
+
𝐹𝑦

𝑑𝑉
= 0                                      (𝐸𝑐 19) 

𝜕𝜏𝑥𝑧
𝜕𝑥

+
𝜕𝜏𝑦𝑧

𝜕𝑦
+
𝜕𝜎𝑧
𝜕𝑧

+
𝐹𝑧
𝑑𝑉

= 0                                       (𝐸𝑐 20) 

𝜏𝑥𝑧 = 𝜏𝑧𝑥                                                                           (𝐸𝑐 21) 

𝜏𝑥𝑦 = 𝜏𝑦𝑥                                                                           (𝐸𝑐 22) 

𝜏𝑦𝑧 = 𝜏𝑧𝑦                                                                           (𝐸𝑐 23) 

Estas ecuaciones se deben resolver de manera analítica, siendo de gran dificultad para casos 

complejos [17], por lo que se puede recurrir también a métodos numéricos.  

2.3.Análisis computacional 

En gran parte de los problemas matemáticos no se logra encontrar una solución única, sino 

que se encuentran soluciones que dependen de otras variables. Para poder zanjar este tipo de 

resolución aparecen los métodos numéricos. Estos últimos, reducen el procedimiento de 

resolución en variables a operaciones aritméticas. Depende de la complejidad del problema 

la cantidad de operaciones aritméticas a resolver. Una parte importante de los métodos 

numéricos son los métodos de elementos finitos [12]. 
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Los métodos de elementos finitos (MEF) son un método de aproximación donde se cambia 

el elemento continuo por una discretización de elementos de largo y propiedades finitas 

llamados nodos. Al generarse estos nuevos elementos separados por nodos los problemas ya 

no pertenecen a una función matemática, sino que se generan nuevas funciones en los 

nodos, para posteriormente generar una función de interpolación o funciones de forma en los 

valores internos de la simulación [11]. 

Para poder trabajar con métodos de elementos finitos se debe estudiar la teoría de trabajos 

virtuales que considera las tensiones y deformaciones virtuales de la estructura, es decir, 

considerando un sistema en equilibrio, se aplica un desplazamiento arbitrario, por lo que se 

considera que el trabajo realizado por las fuerzas externas es equivalente al trabajo realizado 

por los esfuerzos internos.  

                                              𝛿𝑊𝑖𝑛𝑡 =  𝛿𝑊𝑒𝑥𝑡                                                        (𝐸𝑐 24) 

∬ 𝛿휀𝑇𝜎𝑡𝑑𝐴 = ∬ 𝛿𝑢𝑇𝑏𝑡𝑑𝐴
𝐴

+∫ 𝛿𝑢𝑇𝑡𝑡𝑑𝑆
𝑙

+∑𝛿𝑢𝑖
𝑇                  (𝐸𝑐 25)

𝑖𝐴

 

Donde:  

• 𝛿휀 = [𝛿휀𝑥, 𝛿휀𝑦 , 𝛿𝛾𝑥𝑦]
𝑇
 : Representa a las deformaciones virtuales. 

• 𝑡 = [𝑡𝑥, 𝑡𝑦]
𝑇
 : Fuerzas repartidas en el contorno t. 

• 𝛿𝑢 = [𝛿𝑢, 𝛿𝑣]𝑇 : Desplazamiento virtual. 

• 𝛿𝑢𝑖 = [𝛿𝑢𝑖 , 𝛿𝑣𝑖]
𝑇 : Desplazamiento virtual. 

• 𝑏 = [𝑏𝑥, 𝑏𝑦]
𝑇
 : Fuerzas por unidad de volumen b. 

• 𝑞𝑖 = [𝑈𝑖, 𝑉𝑖]
𝑇 : Fuerzas puntuales. 

 

 

 

 

 

 

 

 

 

 

 

Ilustración 11 Caso de estudio con tres nodos para elementos finitos [29]. 
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Discretización del campo de desplazamiento: Se realiza esta actividad para expresar 

desplazamientos del plano cartesiano interior del elemento en función de los nodos. 

                          𝑢 = [
𝑢
𝑣
] = ∑ 𝑁𝑘𝑎𝑘

𝑒 = [𝑁𝑖, 𝑁𝑗 , 𝑁𝑚] {

𝑎𝑖
𝑎𝑗
𝑎𝑚
}

𝑒

= 𝑁𝑎𝑒                        (𝐸𝑐 26)𝑘  

Donde: 

• 𝑢: Vector de desplazamiento. 

• 𝑎𝑖: Desplazamiento de un nodo.  

• 𝑎𝑒: Desplazamiento de todos los nodos. 

• N: Representa las funciones de forma. 

Las funciones de forma se utilizan para que el sistema sea compatible dimensionalmente, y 

así poder obtener los desplazamientos nodales. Una de las principales tareas de las funciones 

de forma es que aseguran desplazamientos continuos según los lados adyacentes [28]. 

Discretización del campo de deformaciones: Su función es obtener las tres deformaciones en 

cualquier punto del elemento en estudio [28]. 

휀 =

{
  
 

  
 

𝜕𝑢

𝜕𝑥
𝜕𝑣

𝜕𝑦
𝜕𝑣

𝜕𝑥
+
𝜕𝑢

𝜕𝑦}
  
 

  
 

=

[
 
 
 
 
 
 
𝜕𝑁𝑖
𝜕𝑥

0
𝜕𝑁𝑗

𝜕𝑥

0
𝜕𝑁𝑖
𝜕𝑦

0

𝜕𝑁𝑖
𝜕𝑦

𝜕𝑁𝑖
𝜕𝑥

𝜕𝑁𝑗

𝜕𝑦

  

0
𝜕𝑁𝑚
𝜕𝑥

0

𝜕𝑁𝑗

𝜕𝑦
0

𝜕𝑁𝑚
𝜕𝑦

𝜕𝑁𝑗

𝜕𝑥

𝜕𝑁𝑚
𝜕𝑦

𝜕𝑁𝑚
𝜕𝑥 ]

 
 
 
 
 
 

{
 
 

 
 
𝑢𝑖
𝑣𝑖
𝑢𝑗
𝑣𝑗
𝑢𝑚
𝑣𝑚}
 
 

 
 

                           (𝐸𝑐 27) 

                                               휀 = 𝐵𝑎𝑒 = [𝐵𝑖𝐵𝑗𝐵𝑚] {

𝑎𝑖
𝑎𝑗
𝑎𝑚
}                                              (𝐸𝑐 27) 

Donde:  

• 𝐵: Matriz de deformaciones. 

                                     𝐵 =  
1

2∆
[

𝑏𝑖 0
0 𝑐𝑖
𝑐𝑖 𝑏𝑖

  
:
:
:
  

𝑏𝑗 0

0 𝑐𝑗
𝑐𝑗 𝑏𝑗

  
:
:
:
  

𝑏𝑚 0
0 𝑐𝑚
𝑐𝑚 𝑏𝑚

]                                     (Ec 28) 

• 𝐵𝑖: Matriz de deformaciones del nodo i. 

                                                              𝐵𝑖 =

[
 
 
 
 
𝜕𝑁𝑖

𝜕𝑥
0

0
𝜕𝑁𝑖

𝜕𝑥
𝜕𝑁𝑖

𝜕𝑥

𝜕𝑁𝑖

𝜕𝑥 ]
 
 
 
 

                                                    (𝐸𝑐 29) 
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Discretización del campo de tensiones: Las tensiones son constantes, producto del campo de 

desplazamientos escogido, por lo que la discretización se logra sustituyendo directamente: 

                                                               𝜎 = 𝐷휀 = 𝐷𝐵𝑎𝑒                                                 (𝐸𝑐 30) 

Ecuaciones de equilibrio de discretización: Utilizando el principio de trabajos virtuales. 

∬ 𝛿휀𝑇𝜎
𝐴𝑒

𝑡𝑑𝐴𝑒 =∬ 𝛿𝑢𝑇𝑏𝑡𝑑𝐴
𝐴𝑒

+ ∫ 𝛿𝑢𝑇𝑡𝑡𝑑𝑠𝑒

𝑙𝑒

+ ∑ 𝛿𝑢𝐾𝑈𝑘 + ∑ 𝛿𝑢𝐾𝑉𝐾 (𝐸𝑐 31)

𝐾=𝑖,𝑗,𝑚𝐾=𝑖,𝑗,𝑚

 

Donde: 

• 𝑏: Fuerzas másicas. {
𝑏𝑥
𝑏𝑦
} Fuerzas repartidas por unidad de área. 

• 𝑡: Fuerzas de superficie. {
𝑡𝑥
𝑡𝑦
} Fuerzas repartidas por unidad de longitud. Puede ser 

por fuerzas exteriores que actúan en el contorno y por fuerza de interacción de las 

moléculas [29]. 

• 𝑞𝑖: {
𝑈𝑥𝑖
𝑉𝑦𝑖
}: Fuerzas nodales de equilibrio. 

• 𝑃𝑖: {
𝑃𝑥𝑖
𝑃𝑦𝑖
}: Fuerzas nodales exteriores. 

• 𝑢𝑘𝑦 𝑣𝑘: Desplazamientos virtuales de los nodos. 

• 𝑈𝑘𝑦 𝑉𝑘: Fuerzas nodales de equilibrio de los desplazamientos nodales. 

Descomponiendo las integrales y reemplazando valores iniciales se obtiene: 

∬ 𝐷𝐵𝑡𝑑𝐴𝑒𝑎𝑒 =∬ 𝐵𝑇𝐷휀0𝑡𝑑𝐴
𝑒 −∬ 𝐵𝑇𝜎0𝑡𝑑𝐴

𝑒 +∬ 𝑁𝑇𝑏𝑡𝑑𝐴𝑒 + ∫ 𝑁𝑇𝑡𝑡𝑑𝑠𝑒

𝑙𝑒

+
𝐴𝑒

𝑞𝑒    (𝐸𝑐 31)
𝐴𝑒𝐴𝑒𝐴𝑒

 

Donde: 

• 𝐾𝑒 : ∬ 𝐷𝐵𝑡𝑑𝐴𝑒
𝐴𝑒

: matriz de rigidez del elemento. 

• 𝑓𝜀
𝑒 : ∬ 𝐵𝑇𝐷휀0𝑡𝑑𝐴

𝑒
𝐴𝑒

: Deformaciones iniciales. 

• 𝑓𝜎
𝑒 : ∬ 𝐵𝑇𝜎0𝑡𝑑𝐴

𝑒
𝐴𝑒

: Tensiones iniciales. 

• 𝑓𝑏
𝑒:∬ 𝑁𝑇𝑏𝑡𝑑𝐴𝑒

𝐴𝑒
: Fuerzas másicas. 

• 𝑓𝑡
𝑒 : ∫ 𝑁𝑇𝑡𝑡𝑑𝑠𝑒

𝑙𝑒
: Fuerzas de superficies. 

Realizando sumatoria de fuerzas nodales equivalentes: 

                                                    𝑓𝑒 = 𝑓𝜀
𝑒 − 𝑓𝜎

𝑒 + 𝑓𝑏
𝑒 + 𝑓𝑡

𝑒                                        (𝐸𝑐 32) 

Reemplazando (Ec 28) en (Ec 27) se tiene que: 
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                                                                 𝐾𝑒𝑎𝑒 = 𝑓𝑒 + 𝑞𝑒                                            (Ec 33)   

Se tiene que la suma de las fuerzas internas nodales debe ser equivalente a las fuerzas 

exteriores nodales [29]. Por lo que finalmente: 

                                                                        𝐾𝑎 = 𝑓                                                     (Ec 34)                                                                         

Donde: 

• 𝐾: Matriz de rigidez. 

• 𝑎: Vector de desplazamientos nodales. 

• 𝑓: Vector de fuerzas nodales equivalentes. (𝑓𝑒 + 𝑞𝑒). 

Una de las primeras experiencias de análisis de elementos finitos en grietas sucedió cuando 

Newman abordó la propagación de una grieta mediante tensión plana [13]. Para este 

método se necesita una ardua concentración y participación del usuario en la realización del 

análisis, al tener que realizar mallado constante en la ubicación de la grieta y los posteriores 

casos de propagación de éstas. Además, se necesita un elevado número de grados de libertad 

para modelar correctamente el problema [14]. Los problemas de mecánica de sólidos no 

incluían el análisis de grietas. Para poder comprender estos estudios no lineales se necesitaba 

una herramienta más poderosa. 

Posteriormente surge el método de elementos finitos extendidos o XFEM (eXtended Finite 

Element Method), que consiste en una malla continua que resuelve problemas discretos. Es 

decir, ya no se tiene que realizar la partición de malla cada vez que hay cambios en el 

fenómeno, sino que se realiza automáticamente [14]. 

Este método se atribuye a Belytschko y Black [8] y consiste básicamente en que se incluye 

el enriquecimiento alrededor de la figura de la fisura, por lo que se podrá analizar con mayor 

cuidado la simulación y resolverse con remallado reducido [14]. Esto sucede por el 

complemento con el método set-level (LSM por Level-Set Method), el cual analiza y entrega 

información sobre el comportamiento de la grieta, mientras que X-FEM define los campos 

de tensiones y desplazamientos.  

Para poder enriquecer el sistema se agregan nuevas funciones a las que ya estaban definidas 

en métodos de elementos finitos, por los que añaden más grados de libertad. 

𝑢 =∑𝑢𝑖𝑁𝑖 +∑𝑏𝑗𝑁𝑗𝐻(𝑥) + ∑ 𝑁𝑘 (∑𝑐𝑘
𝑙1𝐹𝑙

1(𝑥)

4

𝑙=1

) + ∑ 𝑁𝑘 (∑𝑐𝑘
𝑙2𝐹𝑙

2(𝑥)

4

𝑙=2

)

𝐾∈𝐾2𝐾∈𝐾1𝑖∈𝐽𝑖∈𝐼

 

                                                                                                                       (Ec  35) 

Donde: 

• 𝑁𝑖: Función de forma del nodo i. 

• 𝐼: Conjunto de nodos del sistema. 

• 𝐽: Conjunto de nodos del sistema interceptados por una grieta. 

• 𝐾: Conjunto de nodos que en su función de forma está el frente de grieta. 
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• 𝑢𝑖: Grados de libertad clásicos para nodos del sistema. 

• 𝑏𝑗: Abertura de la grieta. Salto de desplazamiento por la grieta en nodo j. 

• 𝐻(𝑥): Función Heaviside. Es una función discontinua de valor constante a ambos 

lados de la grieta, por lo que aumenta los grados de libertad en funciones de fisuras 

de mayor longitud, grietas no rectas, o cuando las funciones de forma están 

interceptadas por las grietas [14]. 

• 𝑐𝑘𝑙: Grados de libertad asociados al enriquecimiento extremo de la grieta. 

• 𝐹𝑙: Función de enriquecimiento de cuatro funciones asintóticas en la expansión del 

campo de desplazamiento punta de la fisura [14]. Esto se produce debido a que 

contienen el extremo de la grieta.  

 

 

 

 

 

Ilustración 12 Enriquecimiento X-FEM (adaptado de [2]). 

2.3.1. Salomé-Meca 

Salomé-Meca [14] es un software de elementos finitos con licencia open source, que nace de 

Salomé y Code-Aster. Salomé-Meca posee un sector de elemento de preprocesamiento, es 

decir, ofrece una interfaz donde el usuario puede introducir y modificar los datos y 

herramientas ya instaladas necesarias para el análisis, y herramientas de post procesamiento, 

para poder analizar los resultados posteriores. Este software consta de varias herramientas 

además del motor de cálculo Code-Aster [14].  

Analysis of Structures and Thermomechanics for Studies and Research (Code-Aster), 

consiste en un software de uso libre de elementos finitos para análisis de estructuras creado 

por EDF. (Électricité de France). Una de sus principales aplicaciones son el análisis 

mecánico, ya sea estático o dinámico, además de ser utilizado para investigaciones en la 

mecánica de sólidos como, por ejemplo, mecánica de la fractura, daño por fatiga, uso de 

medios porosos, etc.  

Mientras tanto, Salomé es un software de carácter libre, que entrega una arquitectura para el 

usuario fácil de utilizar y modificable, donde puede realizar cambios en los módulos 

instalados. Posee interoperabilidad con el sistema CAD y accesibilidad desde el sistema 

Python para tener una consola integrada para su utilización. 
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Módulo GEOM: Este apartado entrega herramientas para la creación, visualización y edición 

de la geometría de los modelos. Es una herramienta de diseño que permite exportar e importar 

archivos de otros softwares, esta función se realiza a través de complementos por lo que 

permite ampliar el rango de archivos compatibles. Algunos archivos compatibles son:  

• .IGES. 

• .STL. 

• .BREP. 

Para crear módulos geométricos el programa facilita la herramienta Salome Geometry que 

permite crear una amplia variedad de figuras y objetos geométricos. Estos pueden ser objetos 

primitivos, objetos completos y objetos complejos. 

Luego de haber exportado o creado el objeto geométrico, el módulo facilita cambiar 

parámetros básicos como, por ejemplo: el nombre, crear grupos de materiales, color, 

transparencia, deflexión, inercia, centro de masa, entre otros. Por otra parte, también entrega 

la oportunidad de transformar las características de fondo del objeto en estudio. En modo de 

ejemplo, operaciones de partición, operaciones con bloques, operaciones de extracción y 

reconstrucción y demás [33].  

Adicionalmente existe la opción de reparación donde se pueden mejorar las formas del 

sistema como, por ejemplo, suprimir agujeros, modificar tolerancia límite, juntar caras [33]. 

 

 

 

 

 

 

 

 

 

Ilustración 13 Módulo GEOM [40]. 

Módulo Mesh: En este apartado se logran generar mallados de análisis numéricos sobre la 

geometría creada en el módulo anterior. Se pueden generar mallados en 1D, 2D Y 3D. Cuenta 

con algoritmos propios permitiendo exportar e importar mallados desde otros softwares. Este 

módulo cuenta con la opción de modificar las mallas que trae por defecto el programa 

computacional, además de crear grupos de elementos y filtrar sus nodos. Una investigación 

realizada en Salomé-Meca puede abarcar múltiples mallas, pero cada una se comporta de 

forma independiente [34]. La principal forma de generar la malla es directamente sobre la 

geometría del modelo (forma principal). Esto incluye adoptar los algoritmos y características 

de su mallado. Posteriormente se pueden generar las mallas secundarias, estas ayudan a 

discretizar sub formas del modelo donde se necesite caracterizar con otros datos [34]. 
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La estructura de una malla está compuesta por nodos y elementos basados de los nodos, estos 

se masifican en el elemento dependiendo de su geometría y la convención de conectividad 

[34].  

Cada trozo de malla se puede asociar a diferentes sub formas. Un ejemplo de aquello son los 

nodos generados en el borde donde asocian su posición con el espacio paramétrico [34]. Las 

entidades (nodos y elementos) se logran localizar mediante números enteros a partir del 1 por 

cuentas separadas.  

Las mallas generadas poseen una característica de control para manejar su visual. Para esto 

se utiliza un algoritmo que calcula el valor de una característica geométrica para todos los 

elementos constituidos en dicha malla evaluada. Existen diversos tipos de evaluadores de 

calidad: [34] 

- Controles de nodo. 

- Controles de borde.  

- Controles de cara. 

- Controles de volumen.  

 

Ilustración 14 Módulo Mesh [40]. 

Por otro lado, existe el complemento SpherePadder. Este consiste en un algoritmo que genera 

partículas esféricas rígidas de tamaño variable con nombre de malla de elementos discretos. 

El objetivo de este complemento es generar un aumento en la densidad y llenar de esferas 

todos los espacios vacíos. Esta propiedad se utiliza para estudiar comportamientos 

discontinuos (fracturas) principalmente en hormigón armado bajo cargas dinámicas de 

impacto o explosiones [34]. 

Módulo Code_Aster: Este módulo logra realizar los cálculos de la simulación en Salomé-

Meca. Son variables la tipología de cálculos lineales o no lineales que se pueden ejecutar con 

esta herramienta entre los cuales se encuentran: [35]. 
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- Análisis estructural estático. 

- Análisis modal. 

- Análisis de fracturas. 

- Acoplado térmico estructural. 

- Interacción fluido-estructura. 

- Análisis dinámico estructural. 

El módulo posee la herramienta Eficas-CodeAster que permite compartir una interfaz gráfica 

con todos los comandos para componer los problemas de métodos de elementos finitos. Por 

otra parte, la herramienta ASTK entrega la facilidad de controlar las simulaciones a realizar 

[35]. 

Este módulo además es compatible con otros programas: 

- Gmsh. 

- FEMAP. 

- Simscale. 

 

 

 

 

 

 

 

 

 

 

Módulo de Post-Procesamiento (ParaVis): En este apartado se ofrecen las herramientas para 

lograr comprender de mejor forma los resultados obtenidos en el módulo anterior. Permite 

visualizar la información de desplazamientos, deformaciones, tensiones fijas en el elemento 

completo o incluso en algún punto aleatorio del sistema. Este módulo admite el análisis de 

datos cuantitativos y cualitativos. La exploración de estos puede realizarse en la interfaz o a 

través de la programación [36].  

La base de código ParaVis está compuesta para que sus elementos puedan ser utilizados en 

varias funciones creando programas altamente versátiles siendo compatibles para resolver 

una gran cantidad de cuestionamientos [36]. 

 

Ilustración 15 Módulo Code_Aster [35]. 



Simulación de propagación de grieta en viga de acero y verificación experimental | Sebastián Moya Lazo 

 

 
34 

 

Los principales objetivos de esta herramienta son:  

- Ser un software de código abierto que se pueda aplicar en múltiples 

plataformas. 

- Soporte para procesar grandes cantidades de datos. 

- Poseer una interfaz abierta, flexible y fácil de entender. 

- Desarrollar arquitectura extensible.  

Y sus principales características son: [36]. 

- Cada procedimiento genera una agrupación de datos, esto permite al usuario 

comprender el análisis por operación.  

- Se puede obtener información de una subregión generando un plano arbitrario 

especificando un criterio para excluir los datos.  

- Los puntos pueden desplazarse en el sistema, aplicando escalares o vectores. 

- Las líneas de corriente se pueden crear usando integradores adaptativos. 

- El desarrollo de los datos se puede realizar mediante la herramienta de Python 

VTK. 

- Los resultados se pueden verificar gráficamente o mediante archivos de texto. 

 

Ilustración 16 Módulo ParaVis [40]. 

2.4.Normativa 

Con respecto al código de diseño en acero, se utiliza Specification for Structural Buildings: 

AISC 2010. Esta normativa procede del American Institute of Steel Construction (AISC), 

que es un instituto sin fines de lucro que entrega criterios de diseño para ocupar el acero como 

material estructural. Emplea combinaciones de carga del método ASD, donde se utilizan 

factores de reducción de la resistencia según el tipo de esfuerzo y LRFD que amplifica los 

esfuerzos mecánicos por un factor mayor a 1 [15]. 
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Para las cargas de sismo se utiliza la NCh 2369 Of. 2003, mientras que para las cargas de 

viento se utiliza NCh 432 Of. 2010. Las combinaciones de cargas asociadas se obtienen de 

NCh 3171 Of. 2010 y NCh 2369 Of. 2003. Estas normas de diseño aplican en Chile para los 

diferentes tipos de materiales estructurales de construcción, son normas que apuntan a las 

diversas tipologías de cargas y su forma de aplicación sobre las estructuras. Para poder 

realizar cualquier tipo de proyecto estructural, se deben respetar estas normas mínimas. 

 

 

 

 

 

 

 

 

 

Ilustración 17 Visualización de cargas estructurales de viento, uso y nieve [41]. 

Ilustración 18 Representación de carga sísmica [42]. 



Simulación de propagación de grieta en viga de acero y verificación experimental | Sebastián Moya Lazo 

 

 
36 

 

CAPÍTULO 3: MARCO METODOLÓGICO 

 

Los estudios mediante los métodos de elementos finitos se efectúan para pronosticar el 

comportamiento físico de un elemento estructural o de una estructura propiamente tal. Los 

ensayos de laboratorio son una herramienta donde se determinan las propiedades y 

características de un material de forma tangible. Es por esto que en la industria se estudian 

una gran cantidad de muestras para asegurar la calidad de los elementos que se están 

utilizando. En la presente memoria se verificarán ambos mecanismos. 

3.1 Diseño de la investigación 

En el marco de la presente memoria se desarrolla un diseño de investigación basado en la 

experimentación, donde se analizará la propagación de una grieta según la cantidad de carga 

que se aplica a una viga. En este estudio se realizarán dos frentes de investigación que 

posteriormente se verificarán. El primero se centra en el laboratorio, donde se realizarán 

ensayos a flexión a una viga de acero con forma dog-bone con una grieta inducida. El 

segundo se realizará mediante un software de elementos finitos llamado Salomé-Meca. Para 

comenzar la investigación en este programa computacional se debe realizar el modelo 

idealizado a estudiar, es decir, que los elementos generados en el software de elementos 

finitos sean comprensibles para éste. Inmediatamente, se debe decidir la cantidad de nodos y 

el tipo de malla que se utilizará para el análisis.  Posteriormente, se definirán las cargas y las 

condiciones de borde del problema, además de aplicar las funciones de análisis para la 

simulación numérica. Finalmente, se verificarán los resultados obtenidos con normas y/o 

algún elemento de control de la simulación. En esta investigación se verificarán los resultados 

computacionales con el ensayo realizado en el laboratorio.  

Para comprender el estudio se identifican dos variables: cantidad de carga aplicada (variable 

independiente) y longitud de avance de la grieta (variable dependiente), en las cuales se 

describe lo siguiente:  

• Cantidad de carga aplicada: Esta es la variable de control de la experimentación, 

puesto que se va modificando y es la acción que se ejerce en el laboratorio para 

obtener las consecuencias de la investigación.  

• Avance de la grieta: Corresponde a una variable dependiente; se desarrolla en 

consecuencia de la aplicación de carga. 

Además de las variables mencionadas, existen otros parámetros que dependen del material 

que se debe tener en consideración, por ejemplo: variables extrañas (módulo de elasticidad, 

módulo de Poisson, composición del acero, imperfecciones y fisuras naturales, radio en el 

criterio de fractura, etc.), variables intervinientes (forma geométrica de la muestra, 

dimensiones del elemento, inercia, entre otras). Estos parámetros son importantes para 

comprender la propagación de la grieta en el material.  
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3.2 Selección de la muestra  

En el laboratorio se ensayarán a tracción dos tipologías de muestras de viga dog-bone. Sus 

dimensiones se ajustan a la prensa hidráulica donde se realizará la experimentación. El primer 

prototipo se trata de un modelo comercial llamado IPE 100, cuya geometría se especifica en 

la ilustración 19.  

El segundo tipo de muestra es el modelo comercial IPE 120, en la siguiente ilustración se 

especifica su geometría. 

 

Ilustración 20 Geometría vista en planta viga IPE 120. [Elaboración propia]. 

Ilustración 19 Geometría vista en planta viga IPE 100. [Elaboración propia] 
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Cabe destacar que ambos modelos comerciales señalados se eligieron estratégicamente 

pensando en la resistencia de éstas y en la carga que produce la prensa hidráulica en la que 

se ensayarán.  

La elección geométrica de la viga es de tipo dog-bone. Esta tipología de elemento posee un 

cambio de sección en el centro de la muestra. Esto genera que el sector mencionado sea más 

débil y que las tensiones se concentren en este lugar, de modo que la grieta se propaga en la 

zona disminuida [37]. 

Por otra parte, las muestras poseen una grieta inducida en el centro de cada elemento, esta 

hendidura es de 3 cm de longitud. La presencia de esta singularidad puede provocar que en 

la viga se produzca una rotura, principalmente porque en los extremos de las grietas suelen 

concentrarse las tensiones. Al ejecutarse el ensayo, éste origina un estado tensional interno 

que, junto a la ubicación de la concentración de tensiones, generará la propagación de la 

grieta [37]. 

Con respecto al software computacional, el programa a utilizar es Salomé-Meca. Esta 

herramienta computacional es de licencia libre y agrupa a una gran cantidad de módulos 

independientes para constituirse. Una de las características de Salomé-Meca es el recurso 

computacional de métodos de elementos finitos extendidos (X-FEM) que permitirá el 

crecimiento de las grietas en estudio mediante las funciones de enriquecimiento. 

Adicionalmente, se puede reducir considerablemente el tiempo de simulación gracias al 

enriquecimiento de la grieta, ya que se debe ajustar solo la malla en ese lugar [14].  

Por otra parte, el software posee una gran flexibilidad, lo que permite trabajar con otros 

programas, pudiendo importar y exportar modelos, mallados, cálculos e información [14].  

Finalmente, se realizará un análisis de resultados para estudiar la convergencia de los valores 

arrojados por las simulaciones con respecto a la realidad. Para esto se calculará un porcentaje 

de error asociado a las coordenadas del frente de grieta, según la siguiente formulación:  

% 𝐸𝑟𝑟𝑜𝑟 =
𝑉𝑎𝑙𝑜𝑟 𝑒𝑥𝑝𝑒𝑟𝑖𝑚𝑒𝑛𝑡𝑎𝑐𝑖ó𝑛 − 𝑉𝑎𝑙𝑜𝑟 𝑠𝑖𝑚𝑢𝑙𝑎𝑐𝑖ó𝑛

𝑉𝑎𝑙𝑜𝑟 𝑒𝑥𝑝𝑒𝑟𝑖𝑚𝑒𝑛𝑡𝑎𝑐𝑖ó𝑛
∗ 100          (𝐸𝑐 36) 

Si el valor arrojado es menor del 5% para cada coordenada, se aceptarán los resultados 

simulados por el software.  

3.3 Operacionalización de las variables 

En una investigación se identifican variables, clasificándolas según su naturaleza, su 

característica observable, su unidad de medida y el rango de variación que puede desarrollar 

en la experimentación. En la tabla 1 se especifican las variables observadas en esta 

investigación.  
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Variable Indicador Medición Rango Variabilidad 

Cantidad de carga 

aplicada 

(Independiente) 

Carga aplicada en 

ambos tercios 

centrales. 

N 0-200000 N 

Avance de la grieta 

(Dependiente) 

Longitud Mm 0-70 mm 

Módulo de 

elasticidad 

(Extraña) 

Relación Tensión-

Deformación 

N/mm2 210000 N/mm2 

Módulo de Poisson 

(Extraña) 

Relación 

Deformaciones 

Longitudinal-

Perpendicular 

Sin Unidad 0.3 

Composición del 

acero al carbono 

(Extraña) 

Cantidad de carbono 

de la aleación 

% 0.3-1.75% 

Imperfecciones y 

fisuras naturales 

(Extraña) 

Superficie con 

granos y fallas 

superficiales 

% m2 0-5% 

Radio en el criterio 

de la fractura 

(Extraña) 

Longitud y ángulo 

de desarrollo 
Mm y ∅ -------- 

Dimensiones del 

elemento 

(Interviniente) 

Longitud Mm 0-10 mm 

Tabla 1 Variables a considerar en la investigación [Elaboración propia]. 

Donde:  

• Cantidad de carga aplicada: Se refiere al incremento de carga que aplica la prensa 

hidráulica a la viga en ensayo. Esta será la responsable de generar concentración de 

tensiones en la viga para lograr la propagación de la grieta. Es la variable 

independiente del problema. 

• Avance de la grieta: Corresponde a la longitud de propagación de la grieta en la viga 

en estudio. Depende de la cantidad de carga aplicada, por lo que es la variable 

dependiente del estudio. 

• Módulo de elasticidad: Se refiere a un parámetro distintivo para cada material que 

relaciona cantidad de tensión con respecto a la deformación que sufrirá.  

• Módulo de Poisson: Corresponde a un parámetro propio de cada material que 

relaciona la deformación longitudinal con respecto a la deformación perpendicular de 

la fuerza aplicada.  

• Composición del acero: Corresponde a la constitución del material; el acero puede 

variar por varios elementos químicos (fósforo, níquel, cromo, azufre, entre otros) y 

en distintos porcentajes.  
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• Imperfecciones y fisuras naturales: Si bien para estudiar los materiales se generan 

idealizaciones, en la práctica ningún material es perfecto y traen consigo defectos de 

fábrica y/o por utilización.  

• Radio en el criterio de la fractura: Corresponde al sector donde se evaluará el cálculo 

de los esfuerzos; lo va guiando la propagación de la grieta. 

• Formación geométrica: Se refiere a la tipología de forma que tiene la muestra. 

(cúbica, prismática, dog-bone, entre otras).  

• Dimensiones del elemento: Corresponde a las medidas longitudinales de la probeta 

(ancho, largo y alto).  

• Inercia: Hace referencia a la propiedad que poseen los cuerpos físicamente para no 

alterar su estado de reposo o movimiento. 

3.4 Recolección de datos 

3.4.1. Ensayo a flexión en el laboratorio 

Las tres probetas de acero tipo IPE 100 y las tres probetas de acero tipo IPE 120, ambas 

tipologías de forma dog-bone se ensayaron a flexión en la prensa hidráulica del laboratorio 

de Ingeniería Civil en Obras Civiles de la Universidad de Talca.  

El experimento del ensayo a flexión se realizó según lo indicado en la NCh 1038 Of 2009.  

Instrumentos 

- Prensa de ensayo. Ésta deberá tener la capacidad suficiente de carga de rotura 

para realizar el ensayo. Podrá tener una tolerancia de error del 1% de la carga. 

- Regla graduada de 1 metro. 

- Balanza digital. 

- Dispositivo de tracción producto de la flexión, con plataforma de apoyo para la 

probeta. 

- Esmeril Angular con disco de corte de 2 mm.  

Procedimiento 

Se realizó la forma de la viga usando un esmeril angular para generar una grieta en el centro 

de la viga, la longitud del corte es de 3 cm con un ángulo de inclinación de 35,55°, como se 

puede apreciar en la ilustración 21. El objetivo era inducir una propagación de la grieta al 

concentrar tensiones en ese lugar cuando comenzará a generarse el ensayo. 
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Ilustración 21 Viga dog-bone con grieta inducida. [Elaboración propia]. 

Posteriormente se dibujó una grilla de ubicación en la probeta (ver ilustración 22) con cinta 

métrica y lápiz corrector. Esto tiene como propósito encontrar las coordenadas de ubicación 

de la grieta con respecto a la altura y el largo de la viga, además de poder analizar con una 

simple inspección inicial la propagación de la grieta.   

 

Continuadamente, se realizaron trazados con cinta métrica y lápiz corrector de la ubicación 

de los apoyos en el ala inferior para ubicarlos en la prensa. De esta forma se posiciona la 

grieta inducida en el eje que se flectará con mayor dimensión en la experimentación. La 

posición de apoyo se estableció a 4 cm. de cada extremo respectivo. (Ver ilustración 23). 

Ilustración 22 Grilla de ubicación en la probeta. [Elaboración propia]. 
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Luego se determinó la posición de la carga por aplicar, lo que depende de la geometría de 

la probeta. Si se cumple la (Ec 36), la carga se debe aplicar en ambos extremos del tercio 

central de la probeta con un valor de (P/2), de lo contrario la carga se aplica en el centro de 

la viga. [38]. 

                                                          𝐿 ≥  3 𝐻                                 (Ec 37)    

Donde: 

L: luz del ensayo. 

H: Altura de la probeta. 

El modelo IPE 100 tenía una altura de 10 cm y un largo de 53 cm, mientras que el modelo 

IPE 120 tenía una altura de 12 cm y un largo de 53 cm. Ambas probetas calificaron para el 

caso de aplicación de la carga en los extremos del tercio central. Se procedió a marcar las 

posiciones de aplicación de la carga con la ayuda de cinta métrica y corrector. 

Ilustración 23 Trazado de posición de los apoyos en la probeta. [Elaboración propia]. 

Ilustración 24 Trazado de la ubicación de la carga. [Elaboración propia]. 
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Posteriormente, se midieron los lados de las probetas y se registraron sus datos. Luego se 

marcó con polvo de tiza el radio cercano a la grieta inducida para verificar de mejor forma 

su propagación. Se procedió a generar una limpieza en la superficie de las piezas de apoyo, 

cargas y zonas de contacto del ensayo. Se colocó la probeta en la máquina de ensayo, 

debiendo dejar la cara con grieta inducida hacia abajo, haciendo coincidir las líneas trazadas 

con las piezas de apoyo y carga. (Ver ilustración 25).  

Se comenzó el ensayo aplicando la carga de forma continua y uniformemente, donde la 

velocidad de tensión se encontró en 0.01 (N/mm2/s) [38]. Cabe destacar que se tomó 

registros numéricos del procedimiento. (Carga máxima, ancho y longitud de la propagación 

de la grieta, entre otros.).  

La prensa hidráulica funciona abriendo una válvula que permite el flujo de aceite para el 

accionado del descenso de la prensa. Con un control se presiona para aumentar la velocidad 

de la aplicación de la carga hasta que la prensa, con un sensor, señala que se ha alcanzado 

la probeta, momento en el que la prensa comienza a aplicar la carga según la velocidad 

programada. La prensa funcionó hasta observar la propagación de la grieta y la 

plastificación de la probeta (Ver ilustración 26).  

 

Ilustración 25 Probeta en prensa hidráulica para ensayo a flexión. [Elaboración propia]. 

Finalmente, se apagó el motor, cerrando la válvula del flujo de aceite para que la prensa 

volviera a su estado inicial.  
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Ilustración 26 Probeta plastificada y con grieta propagada. [Elaboración propia]. 

En la tabla 2, se pueden apreciar las dimensiones geométricas de las probetas IPE 100 antes 

de realizar el ensayo a flexión, mientras que para las probetas IPE 120, se pueden apreciar 

los mismos parámetros en la tabla 3.  

Dimensiones (mm) Probeta 1 Probeta 2 Probeta 3 

Alto ala izquierda 5.70 5.70 5.70 

Alto ala derecha 5.70 5.71 5.70 

Alto ala promedio 5.70 5.71 5.70 

Alto alma izquierda 88.60 88.50 88.60 

Alto alma derecha 88.60 88.60 88.70 

Alto alma promedio 88.60 88.60 88.70 

Ancho ala izquierda 55.00 55.00 54.90 

Ancho ala derecha 54.90 55.00 54.90 

Ancho ala promedio 55.00 55.00 54.90 

Ancho alma izquierda 4.10 4.11 4.11 

Ancho alma derecha 4.10 4.10 4.11 

Ancho alma promedio 4.10 4.11 4.11 

Coordenada grieta en 
largo 

25.20 25.40 25.40 

Coordenada grieta en 
alto 

2.60 2.80 2.80 

Tabla 2 Dimensiones geométricas de las probetas IPE 100. [Elaboración propia]. 
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Dimensiones (mm) Probeta 1 Probeta 2 Probeta 3 

Alto ala izquierda 6.30 6.30 6.30 

Alto ala derecha 6.30 6.29 6.28 

Alto ala promedio 6.30 6.30 6.29 

Alto alma izquierda 107.40 107.50 107.40 

Alto alma derecha 107.30 107.50 107.40 

Alto alma promedio 107.4 107.50 107.40 

Ancho ala izquierda 64.00 64.00 64.00 

Ancho ala derecha 64.00 64.00 64.00 

Ancho ala promedio 64.00 64.00 64.00 

Ancho alma izquierda 4.41 4.40 4.40 

Ancho alma derecha 4.40 4.40 4.40 

Ancho alma promedio 4.41 4.40 4.40 

Coordenada grieta en 
largo 

25.50 25.40 25.70 

Coordenada grieta en 
alto 

2.70 2.70 2.60 

Tabla 3 Dimensiones geométricas de las probetas IPE 120. [Elaboración propia]. 

3.4.2. Simulación Computacional. 

Salomé-Meca es un software que ofrece una gran cantidad de herramientas para dar 

soluciones a distintos problemas de mecánica estructural. El siguiente experimento consiste 

en una simulación computacional que investiga ensayos a flexión en el programa antes 

mencionado. El estudio se centra en la propagación de las grietas mientras se aplican las 

cargas, además de la deformación que se genera en la viga en el mismo tipo de ensayo.  

Conforme a lo realizado en el laboratorio, se generan dos tipologías de modelo con las 

dimensiones y características de las vigas tipo dog-bone IPE 100 e IPE 120. Además, se 

generan estudios con diferentes tipos de mallas con el objetivo de analizar la convergencia 

de resultados arrojados por el software.  

• Módulo Geometry. 

Para dar comienzo a la simulación computacional se generó un nuevo modelo, para lo cual 

se debe ingresar en el módulo Geometry. Inmediatamente, se generó un diálogo donde se da 

la opción de iniciar un modelo nuevo o abrir uno ya existente; en este caso se comenzó una 

nueva muestra. Luego de ingresar al módulo, se dio comienzo a la idealización de la figura. 

Para esto, el programa entrega las herramientas de formación. Adicionalmente, deja utilizar 

modelos realizados en otros softwares. En este caso se importaron 5 modelos realizados en 

el programa Autodesk Inventor que facilitó la realización de la geometría de la viga dog-

bone. Se decidió realizar esta cantidad de modelos particionando el original para asegurar el 

reconocimiento de la forma por parte del software.  Para importar los elementos se ingresó 

en File → Import → Step. En la ilustración 27 se pueden ver las cinco figuras disponibles en 

el módulo GEOM.  
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Para poder ensamblar los modelos importados en una sola viga dog-bone se utiliza el 

comando Build Compound, donde este permite formar una figura compuesta. En la 

ilustración 28 se puede apreciar la interfaz que genera el comando señalado.  

 

 

Posteriormente se rota y se traslada el elemento para alinear el ancho, el largo y el alto con 

respecto al origen de las coordenadas. Primero se debe dirigir al comando Rotation y se rota 

el elemento en 90° con respecto al eje y, continuamente, se genera una rotación de 90° con 

en relación con el eje x, logrando con esto posicionar los ejes de la figura con respecto a los 

ejes del software. En la ilustración 29 se puede apreciar las opciones generadas por el 

comando mencionado.  

 

 

 

Ilustración 27 Figuras importadas en el módulo Geometry. [Elaboración propia]. 

Ilustración 28 Ventana del Comando Build Compound del módulo Geometry. [Elaboración propia]. 
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Posteriormente, se procede a trasladar la viga al punto de origen de las coordenadas, para 

lograr este propósito se accede al comando Traslation y se aplica un factor, que depende de 

las unidades con las que se trabaje, entorno a las coordenadas en x. En la ilustración 30 se 

verifica la interfaz del comando para traslaciones mediante distancia específica.  

 

 

 

 

 

 

 

 

 

 

Mientras que para las coordenadas en z e y, se realiza una traslación mediante el punto de 

aplicación, esta consiste en tomar un punto cualquiera de la figura y posteriormente declarar 

el punto donde se quiere trasladar, en este caso el origen. En la ilustración 31 se puede 

apreciar la pantalla generada por el comando para una traslación con respecto a un punto.  

Ilustración 29 Ventana del Comando Rotation del módulo Geometry [Elaboración propia]. 

Ilustración 30 Interfaz del comando Traslation con respecto a una distancia fija. [Elaboración propia]. 
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El siguiente paso fue generar grupos para colaborar en la comprensión de la simulación, por 

lo que se debieron completar las siguientes indicaciones: New Entity → Group → Create 

Group. En este ejemplo se generaron 2 grupos de elementos, el primero hace referencia a la 

posición donde se aplicará la carga en la cara superior de las muestras, y el segundo, agrupa 

la posición donde se apoyarán los elementos en la cara inferior. Para ambos, en el apartado 

Shape Type se seleccionó la segunda opción (ver ilustración 32), que indica que son 

elementos de línea.  

 

 

 

 

 

 

 

 

 

 

 

 

Ilustración 31 Ventana del comando Traslation con respecto a un punto determinado. [Elaboración propia]. 

Ilustración 32 Interfaz del comando create group. [Elaboración propia]. 
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Finalmente, el modelo terminado en el módulo Geometry se puede apreciar en la ilustración 

33, la figura se exporta en formato step para posteriormente continuar con la simulación. 

 

 

• Módulo Mesh.  

Con la geometría ya establecida, el siguiente paso es adoptar el mallado para la figura. Esto 

se fundamenta en que es un software de elementos finitos, por lo que es necesario asignar 

modelos matemáticos de cálculo. Para lograr realizarlo, se accedió al módulo Mesh → Create 

Mesh. Estos pasos generaron la siguiente ventana (ver ilustración 34), donde se debió señalar 

la geometría a estudiar y el tipo de malla; en este caso fue el mallado 3D tetrahedralization. 

El mallado elegido al ser de tipo piramidal permite un mejor ajuste en las secciones curvas 

del modelo dog-bone. Eso trae consigo un análisis más representativo de la simulación.  

 

 

 

 

 

 

 

 

 

 

 

Ilustración 33 Modelo terminado en módulo Geometry. [Elaboración propia]. 

Ilustración 34 Interfaz de la creación del mallado, módulo Mesh. [Elaboración propia]. 
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Al asignar la geometría del mallado, se genera la pantalla de hypothesis construction, en esta 

interacción con el programa se señala el volumen máximo del mallado (ver ilustración 35). 

En esta investigación se utilizarán 5 dimensiones de malla, donde el largo máximo será de 

50 mm, 25 mm, 12.5 mm, 10 mm y 5 mm, por lo que se deberá repetir el mismo 

procedimiento para cada una de ellas. 

 

 

 

 

 

 

 

 

  

Posteriormente se debió computar el mallado, lo cual se realizó para que el modelo 

comprendiera la malla declarada. Para esta actividad se debió ingresar en la opción Mesh → 

Compute. Posteriormente, se obtuvo la figura con la respectiva malla, como se puede apreciar 

en la ilustración 36. 

 

 

Luego de generada la malla, el siguiente paso es asignar los grupos declarados en el módulo 

Geometry al mallado, para esto se accede al comando Mesh → Create group from geometry 

donde se declara la malla y los grupos de carga y apoyo tal como se representa en la 

ilustración 37. 

Ilustración 35 Declaración del volumen del mallado. [Elaboración propia]. 

Ilustración 36 Mallado asignado a la viga tipo dog-bone [Elaboración propia]. 
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Posteriormente se exporta el modelo mallado en un archivo med y se selecciona que se 

carguen los grupos automáticamente para cuando se ingrese al archivo nuevamente, tal como 

se puede apreciar en la ilustración 38. 

 

 

Nuevamente, se vuelve a importar la malla y el software automáticamente reconoce los 

grupos de nodos como se puede apreciar en la ilustración 39. Para efectos de esta 

investigación se debe dar click derecho en el contenido de Groups of edges y Groups of face 

y seleccionar delete groups with contents. Esta acción se realiza para discriminar la 

información del mallado que se utilizará posteriormente en el motor de cálculo del software. 

Ilustración 37 Declaración de grupos al mallado asignado. [Elaboración propia]. 

Ilustración 38 Exportación del modelo con el mallado. [Elaboración propia]. 
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A continuación, se debe dar click a modification → transformation → Merge nodes. Luego 

se debe señalar el mallado tal como se aprecia en la ilustración 40. Esta acción se realiza para 

conectar los nodos que no se encuentren unidos al mallado. 

 

 

Para finalizar el trabajo en el módulo Mesh, se accede a modification → transformation → 

Merge elements. Se informa el mallado tal como se muestra en la ilustración 41. El objetivo 

de este comando es conectar los elementos que se encuentren desunidos de la malla. Al 

completar estar acción para efectos de esta investigación, ya se está en condiciones de acceder 

al módulo Aster Study.  

 

 

 

 

 

 

 

 

Ilustración 39 Grupos creados en el mallado. [Elaboración propia]. 

Ilustración 40 Revisión de unión de los nodos en el mallado. [Elaboración propia]. 

Ilustración 41 Revisión de unión de los elementos en el mallado. [Elaboración propia]. 



Simulación de propagación de grieta en viga de acero y verificación experimental | Sebastián Moya Lazo 

 

 
53 

 

• Aster Study 

Este módulo es el motor de cálculo de Salomé-Meca, por lo que en este apartado se declaran 

las condiciones para realizar una correcta simulación. Para comenzar se debe declarar un 

nuevo escenario de estudio y para esto se debe dar click derecho en Case_1 → Stage_1. Con 

esta secuencia se logra activar el menú de procesamiento de Aster Study (Ver ilustración 42).  

 

 

 

 

 

 

 

 

 

 

 

 

Luego, se debe declarar el mallado generado en el módulo anterior. Para lograr este paso se 

accede a Mesh → Read a Mesh → Mesh file location y se carga el módulo que se quiere 

trabajar, en la ilustración 43 se aprecia la interfaz generada.  Además, se visualiza en el sector 

izquierdo de la ilustración 44 que se va generado un pseudocódigo con las funciones 

declaradas en el módulo. 

 

 

 

Ilustración 42 Comandos del módulo Aster Study. [Elaboración propia]. 
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Posteriormente, se debe definir el modelo a estudiar. Para lograr esto se debe ingresar en 

Model definition → Assign finite element. En la ilustración 45 se ve la ventana generada al 

seguir estas indicaciones.  Luego se accede a Finite element assignement  → Edit → Group 

of element → Group_of_all_volumenes. Los pasos recientes se realizan para informar al 

motor de cálculo, el grupo de todos los volúmenes generados en el mallado del módulo Mesh. 

A continuación, se ingresa en Model definition → Assign finite element → Finite element 

assignement → Edit → Phenomenon → Mechanic. Además, en el apartado Modelisation → 

3D. Esta secuencia se realiza para declarar que el modelo a estudiar es volumétrico de 

tipología mecánica. 

Ilustración 43 Ventana del comando Mesh de Aster Study. [Elaboración propia]. 

Ilustración 44 Pseudocódigo del trabajo realizado en Aster Study [Elaboración propia]. 
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Luego se debe declarar y asignar a la figura creada el tipo de material y sus propiedades 

asociadas. Para esto se accede en Material → Define a material → Linear isotropic elastic → 

Edit. En la ventana generada se declaran las propiedades constitutivas del material como lo 

son el módulo de Young y el módulo de Poisson (Ver ilustración 46). Posteriormente se entra 

en Material → Assign a material → Model (Ver ilustración 47). Esta cadena se realiza para 

declarar el modelo definido anteriormente. Luego se asigna en Material → Assign a material 

→ Material assignement → Edit → Group of element → Edit → Group_of_all_volumenes. 

Esta secuencia se realiza para asignar el volumen del modelo al material recientemente 

creado.  A continuación, se ingresa en Material → Assign a material → Material assignement 

→ Edit → Material → Edit. Con estos pasos se asigna el material declarado al modelo ya 

definido con su respectivo mallado. 

 

 

 

 

 

 

 

 

 

Ilustración 45 Ventana de asignación del mallado al modelo. [Elaboración propia]. 

Ilustración 46 Declaración de las propiedades constitutivas del acero. [Elaboración propia]. 
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Ahora, se declaran las condiciones de borde y variables externas del problema, para esto se 

accede a BC and Load → Assign mechanical load → Enforce DOF → Edit → Group of node 

→ Edit → Apoyo. Lo que se realiza en la cadena anterior es asignar el grupo de apoyo al 

motor de cálculo, además en Enforce DOF se declara las condiciones iniciales en los apoyos 

en Dx, Dy, Dz. (Ver ilustración 48).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Inmediatamente después, se accede a BC and Load → Assign mechanical load → Force 

Nodal → Edit → Group of node → Edit → Carga. Esta secuencia indica la asignación de las 

condiciones iniciales de la carga, es decir, se declara en Fz respetando las condiciones 

gravitacionales. Además, se debe verificar la cantidad de nodos de carga que posee el 

Ilustración 47 Declaración del modelo para asignar el material definido. [Elaboración propia]. 

Ilustración 48 Interfaz para declarar las condiciones de apoyo. [Elaboración propia]. 
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mallado, por lo que la carga a ingresar se debe dividir por la cantidad de nodos que el sistema 

reconoce. (Ver ilustración 49). 

 

 

Al tener ya declaradas las propiedades constitutivas del material, las condiciones de borde y 

el mallado de cálculo, se está en condiciones de declarar el tipo de análisis que se requiere 

para resolver la simulación. Para esto hay que acceder en Analysis → Static mechanical 

analysis → material field (Ver ilustración 50). En esta secuencia se asigna el material en 

estudio al análisis. Luego en Static mechanical analysis se declara el modelo ya configurado 

en el comando Model. Así mismo se declara la carga y los apoyos asignados en las 

condiciones de borde en el comando Loads en Static mechanical analysis. A continuación, 

se realiza la siguiente secuencia Analysis → Static mechanical analysis → Option →
 SIEF_ELGA. Este comando calcula las tensiones y los esfuerzos internos en los puntos de 

Gauss de cada elemento. 

 

 

 

 

 

 

 

 

 

 

Ilustración 49 Visualización de los nodos de aplicación de la carga. [Elaboración propia]. 

Ilustración 50 Asignación del material al tipo de análisis que se realizará. [Elaboración propia]. 
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Con lo anterior se ha completado el análisis lineal del modelo donde se pueden obtener los 

resultados preliminares, si bien todavía no existe la propagación de la grieta, en las siguientes 

secuencias de pasos se declarará. 

Para realizar el estudio de la grieta se debe ingresar en el apartado Fracture and fatigue → 

DEFI_FISS_XFEM → DEFI_FISS → FORM_FISS (Ver ilustración 52) → DEMI_PLAN. La 

secuencia anunciada se realiza para generar una discontinuidad en el modelo lineal ya 

generado y el tipo de interrupción. Al ejecutarse estos pasos se desbloquean los comandos: 

• PFON: Será la referencia de la propagación de la fisura, es el llamado punta de la 

grieta. 

• PNOR: Indica la dirección normal de la fisura con respecto al modelo. 

• PTAN: Es la dirección tangente de la grieta.  

Los datos que se ingresen en estas casillas darán origen a la inclinación de la grieta con 

respecto al plano horizontal. En la ilustración 53 se ejemplifica la aplicación de los datos con 

respecto a la punta de la grieta. 

 

 

 

 

 

 

 

 

 

 

 

 

Ilustración 51 Pseudocódigo del análisis lineal de las muestras. [Elaboración propia]. 

Ilustración 52 Definición del tipo de discontinuidad en el modelo. [Elaboración propia]. 
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Posteriormente, se ingresa nuevamente al apartado de Model definition → Assign finite 

element → Finite element assignement → Edit → Group of element → Edit → 

Group_of_all_volumenes.  De la misma forma, se accede a Model definition → Assign finite 

element → Finite element assignement → Edit → Phenomenon → Mechanic → Modelisation 

→ 3D. Se realizan estas secuencias de pasos para generar otro modelo de estudio para la 

figura agrietada, seleccionando nuevamente que se trata de un estudio mecánico, con 

modelado 3D. Además, se le debe asignar un nombre distinto para diferenciarlo del estudio 

sin agrietamiento, en este caso se llamó mod_gr1. (Ver ilustración 54). 

 

 

 

 

 

 

 

 

 

 

 

Posteriormente, se ingresa al apartado Fracture and fatigue → MODI_MODELE_XFEM  → 

MODELE_IN → mod_gr1. A continuación, se accede a la opción Fracture and fatigue → 

MODI_MODELE_XFEM  → FISSURE → xfem (DEFI_FISS_XFEM). Con lo desarrollado 

Ilustración 53 Ingreso de datos para el reconocimiento de la discontinuidad. [Elaboración propia]. 

Ilustración 54 Generación del modelo discontinuo. [Elaboración propia]. 
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en estos comandos se genera un nuevo modelo con propiedades XFEM para la muestra 

discontinua recientemente creada. Se le asigna el nombre de mod_xf1. 

 

 

 

 

 

 

 

 

 

 

 

Al modelo XFEM recientemente creado se le debe asignar un material y los grupos de 

elementos volumétricos, para esto se accede a Material → Assign a material → Model → 

mod_xf1 (MODI_MODELE_XFEM). De la misma forma se ingresa a Material → Assign a 

material → Group of element → Edit → Group_of_all_volumenes. Finalmente se entra en 

Material → Assign a material → Mesh, declarando el mallado a estudiar. Luego, como se 

logra verificar en la ilustración 56, se guarda con un nombre distinto al material creado 

anteriormente, en este caso será mat_xf1. 

 

 

 

 

 

 

 

 

 

 

A continuación, se declaran las condiciones de borde y valores iniciales para el modelo 

XFEM, para esto se ingresa en BC and Load → Assign mechanical load → Model → 

Ilustración 55 Creación del modelo con propiedades XFEM. [Elaboración propia]. 

Ilustración 56 Asignación del material al modelo XFEM. [Elaboración propia]. 
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mod_xf1 → (MODI_MODELE_XFEM). Se realiza esta secuencia para que el software 

comprenda el modelo que posteriormente se le asignaran las condiciones iniciales. De la 

misma forma, se ingresa a BC and Load → Assign mechanical load → Enforce DOF → Edit 

→ Group of node → Apoyo. Luego en Enforce DOF se declara los valores iniciales para los 

apoyos Dx, Dy, Dz (Ver ilustración 57). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

De la misma forma se accede a BC and Load → Assign mechanical load → Force Nodal → 

Edit → Group of node → Edit → Carga. Estos pasos generan la asignación de las condiciones 

iniciales de la carga para el modelo XFEM, tomando las mismas precauciones señaladas 

anteriormente para el caso sin agrietamiento. Finalmente se guarda la asignación con un 

nombre distinto al anterior como se puede ver en la ilustración 58. 

 

 

 

 

 

 

 

 

 

 

 

Luego de tener informadas las condiciones iniciales, las mallas de cálculo, la geometría y el 

tipo de modelo se debe señar la tipología de análisis que tendrá la simulación, para esto se 

debe ingresar en Analysis → Static mechanical analysis → Material field → mat_xf. De la 

misma forma se debe acceder a Analysis → Static mechanical analysis → Model → mod_xf. 

Ilustración 57 Asignación de condiciones iniciales para los apoyos, modelo XFEM. [Elaboración propia.] 

Ilustración 58 Asignación de condiciones iniciales de carga para el modelo XFEM. [Elaboración propia]. 
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Finalmente se ingresa en Analysis → Static mechanical analysis → Load → Edit → carg_xf1. 

Estas secuencias de comandos declaran los parámetros desarrollados anteriormente para la 

realización del análisis mecánico estático. Adicionalmente se completa la secuencia de 

Analysis → Static mechanical analysis → Option → SIEF_ELGA. Se modifica el nombre 

para diferenciar del análisis declarado previamente.  

 

 

 

 

 

 

 

 

 

 

 

Para estimar la propagación de la grieta se debe calcular el factor de intensidad de tensiones, 

para poder obtener este factor, se debe localizar la concentración de estas en un radio cercano 

a la fisura. Para alcanzar esto se debe ingresar en Fracture and Fatigue → CALC_G → Option 

→ CALC_K_G. Luego se accede a Fracture and Fatigue → CALC_G → Result → res_xf. 

Finalmente se ingresa en Fracture and Fatigue → CALC_G → Theta → Edit → Fissure → 

xfem (DEFI_FISS_XFEM). Se le asigna un nombre y se continua la simulación.  

 

 

 

 

 

 

 

 

 

 

 

Ilustración 59 Declaración del análisis mecánico estático para modelo XFEM. [Elaboración propia]. 

Ilustración 60 Asignación de cálculo del factor de intensidad de tensiones. [Elaboración propia]. 
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Luego, se debe asignar el estudio de la propagación de la grieta en el elemento XFEM, para 

esto se accede en Fracture and Fatigue → PROPA_FISS → MÉTHODE_PROPA → 

SIMPLEXE. Luego se declara el modelo que se estudiará la propagación, se ingresa en 

Fracture and Fatigue → PROPA_FISS → Model → mod_xf. Posteriormente, se selecciona un 

orden de propagación, donde en este caso se asigna un límite de propagación para los ciclos 

de carga que se aplicarán en el software, para esto se entra en Fracture and Fatigue → 

PROPA_FISS → DA_MAX. De la misma forma, se le da la información al software del radio 

de ramificación probable que tenga la grieta, en este valor la XFEM extenderá su función de 

enriquecimiento para el cálculo de la propagación de la fisura. Se debe acceder a Fracture 

and Fatigue→ PROPA_FISS → RAYON. Finalmente se da el nombre de la propagación en el 

comando Fracture and Fatigue → PROPA_FISS → FISSURE → Edit → FISS_PROPAGEE.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Continuando, se debe declarar el tipo de estudio de propagación de la grieta, cuando ésta deja 

de crecer a nivel de grano y abandona el estudio elastoplástico para basarse en la ley de Paris 

[33], donde los parámetros C Y M dependen del tipo de material, en este estudio se declaran 

para un acero A36 [43]. Se ingresa dicha teoría en Fracture and Fatigue→ PROPA_FISS → 

LOI_PROPA → LOI → PARIS. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Ilustración 61 Asignación de longitud de propagación por ciclo de carga y radio de ramificación de la grieta. [Elaboración propia]. 

Ilustración 62 Asignación de la ley de Paris. [Elaboración propia]. 
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Finalmente, se establece condiciones de carga máxima y mínima en los ciclos de fatiga. Para 

esto se debe acceder en Fracture and Fatigue→ PROPA_FISS → COMP_LINE.  

 

 

 

 

 

 

 

 

 

 

 

Para visualizar la propagación de la grieta con los diversos ciclos de carga, se puede verificar 

en el mallado después de la acción del XFEM, para esto se accede a Fracture and Fatigue → 

POST_MAIL_XFEM → Model → mod_xf. Luego se le asigna un nombre como aparece en la 

ilustración 64. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Para finalizar la programación de la simulación se relaciona el modelo XFEM creado con los 

resultados del modelo XFEM otorgados por la simulación. Para esto se accede en Fracture 

and Fatigue → POST_CHAM_XFEM → Result → res_xf1. De la misma forma se ingresa a 

Fracture and Fatigue → POST_CHAM_XFEM → MODELE_VISU → mod_xf1. Se le asigna 

un nombre y se guarda. 

Ilustración 63 Interfaz del comando PROPA_FISS con los parámetros completos. [Elaboración propia]. 

Ilustración 64 Ventana del comando POST_MAIL_XFEM. [Elaboración propia]. 
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Luego de terminar la programación de la simulación se deben obtener los archivos de 

resultados, para esto se debe ingresar en Output → Set output results. Se debe asignar el 

nombre al archivo de salida. Es requisito que comience con la palabra salida y termine con 

la palabra .rmed como se puede apreciar en la ilustración 66.  

 

 

Posteriormente, se ingresan las asignaciones realizadas en POST_CHAM_XFEM y 

POST_MAIL_XFEM. Para esto se siguen las siguientes secuencias. Output → Set output 

results → Results → Edit → Mesh → mail_xf1. De la misma forma se ingresa a Output→Set 

output results  → Results → Edit → Result → cham_xf1 

 

 

 

 

 

 

 

 

 

 

 

Ilustración 65 Ventana del comando POST_CHAM_XFEM. [Elaboración propia]. 

Ilustración 66 Ejemplificación de nombre de salida para los resultados. [Elaboración propia]. 

Ilustración 67 Interfaz para establecer condiciones XFEM para los resultados. [Elaboración propia] 
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Luego de programar la salida de los resultados, se dirige a la plataforma de cálculo History 

view donde se simula el modelo que se ha procesado en el botón Run, si aparece el botón Run 

case en verde significa que el modelo no tuvo fallos y se puede ingresar al siguiente modulo 

llamado Paravis. 

 

 

 

 

 

 

 

 

 

 

 

 

• Módulo Paravis 

Este módulo funciona como visualizador de resultados, entregando una interfaz con 

herramientas que permiten ver la simulación en 3D, posee filtros que plasman la propagación 

de la grieta, además se puede observar la deformación tras la aplicación de la carga. Por otra 

parte, en el interior de la figura también entrega información con respecto a las coordenadas, 

donde se pueden identificar los distintos cambios que se sufrió en la simulación.  

Para comenzar se debe abrir el archivo de salida que se obtuvo en el módulo Aster Study, 

para eso se da click derecho en pipeline browser →  open y se carga el archivo con el nombre 

de la salida asignado en el módulo anterior.  

 

Ilustración 68 Interfaz para iniciar la simulación. [Elaboración propia] 

Ilustración 69 Modelo cargado en Paravis. [Elaboración propia]. 
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Posteriormente, se accede a la ventana de properties y se selecciona ComSup0, 

REVIg_1_SIEF_ELGA y REVig_6_DEPL (Ver ilustración 70). El número que acompaña los 

últimos comandos depende directamente de la cantidad de iteraciones que se realizó en la 

simulación. Luego se da click en GenerateVectors → Apply. A continuación, se accede al 

comando Filters → Common → Warp by vector → Apply. Al completar la secuencia anterior 

se podrá ver la grieta ya propagada en el modelo cargado en el módulo (Ver ilustración 71).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Luego se ingresa en properties → coloring → REVIg_6_DEPL, para después seleccionar que 

se quiere visualizar el comando Surface with Edges en reemplazo de Surface. En esta 

secuencia, lo que se logra es agregar color al modelo de la grieta propagado para entregar 

resultados en la interfaz, adicionalmente aparece el mallado asociado a los resultados (Ver 

ilustración 72). 

Ilustración 71 Grieta propagada en módulo Paravis. [Elaboración propia]. 

Ilustración 70 Ventana properties del módulo Paravis. [Elaboración propia]. 
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Finalmente, el módulo Paravis puede entregar los resultados de las simulaciones en tablas. 

Para obtener aquello, se debe ingresar en Layout 2 → SpreadSheet View. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Ilustración 72 Modelo agrietado con resultados en interfaz del módulo Paravis. [Elaboración propia]. 

Ilustración 73 Tablas de datos generadas en Paravis. [Elaboración propia]. 
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CAPÍTULO 4: ANÁLISIS DE RESULTADOS 

 

En este capítulo se darán a conocer los resultados obtenidos a través de la experimentación 

en el laboratorio y los obtenidos por parte de la simulación computacional. Luego de 

establecer los valores numéricos, se realiza la interpretación de estos para aceptar o rechazar 

la convergencia de las variables y sus resultados numéricos. 

4.1 Análisis de resultados en ensayos a flexión en el laboratorio 

4.1.1 Viga IPE 120 

Las tres vigas de acero IPE 120 fueron las primeras en ensayarse en la prensa hidráulica. El 

objetivo del ensayo realizado fue medir la máxima carga aplicada (KN), la propagación de 

la grieta en (cm), y las coordenadas del frente de grieta con respecto a un eje asignado en un 

extremo de la probeta. Los resultados de los ensayos fueron los que se muestran en la tabla 

número 4.  

Nº de probeta 
ensayada 

Probeta 1 Probeta 2 
 

Probeta 3 Promedio de probetas  

Carga máxima aplicada 
(KN) 

70.22 60.14 59.49 63.28 

Coordenadas en el 
largo de la viga (cm). 

27.80 27.80 27.80 27.80 

Coordenadas en la 
altura de la viga (cm). 

3.70 3.60 3.70 3.67 

Propagación de la 
grieta (cm). 

1.30 1.20 1.30 1.23 

Tabla 4 Resultados experimentales para viga IPE 120. [Elaboración propia]. 

En la tabla anterior, se identifica que la carga máxima aplicada para este tipo de viga, en las 

probetas 2 y 3, fue de variación mínima; en cambio para la probeta 1 fue mayor. Con respecto 

a las coordenadas de ubicación del frente de grieta ya propagada, se identifica que en las tres 

probetas se obtienen valores similares, siendo la ubicación promedio en las coordenadas 

27.80 centímetros en su largo y 3.67 centímetros en su alto. Adicionalmente, la propagación 

de fractura promedia fue de 1.23 cm, donde la primera y la tercera muestra tuvieron idéntica 

propagación, mientras que en la segunda probeta hubo una propagación menor. A 

continuación, se ven las gráficas de propagación de la grieta, y de las nuevas coordenadas 

del frente de grieta en las 3 probetas ensayadas. (Ver ilustraciones 74 y 75 respectivamente). 
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Ilustración 74 Gráfica experimental de propagación de la grieta en viga IPE 120. [Elaboración propia]. 

 

Ilustración 75 Ubicación en el plano de la ubicación del frente de grieta ensayado en viga IPE 120. [Elaboración 

propia]. 
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4.1.2 Viga IPE 100 

Posteriormente se ensayaron las tres vigas IPE 100. De la misma forma que las muestras 

anteriores, se obtuvo la medición de carga aplicada (KN), las coordenadas del frente de grieta 

(cm) y la propagación de la grieta (cm). Los resultados de la experimentación se pueden 

apreciar en la siguiente tabla. 

Nº de probeta 
ensayada 

Probeta 1 Probeta 2 
 

Probeta 3 Promedio de probetas 

Carga máxima aplicada 
(KN). 

34.00 31.46 37.20 34.22 

Coordenadas en el 
largo de la viga (cm). 

27.90 27.70 28.00 27.87 

Coordenadas en la 
altura de la viga (cm). 

3.90 3.80 3.80 3.83 

Propagación de la 
grieta (cm). 

1.40 1.20 1.00 1.20 

Tabla 5 Resultados experimentales para viga IPE 100. [Elaboración propia]. 

En la tabla 5, se aprecian los resultados obtenidos en el ensayo de laboratorio de la viga IPE 

100. Con respecto a la carga máxima aplicada, el promedio fue de 34.22 KN y el rango de 

aplicación estuvo entre 34.00 KN y 37.20 KN. Por otra parte, la propagación de la grieta se 

registró entre 1.40 cm y un 1.00 cm, obteniéndose como promedio una propagación de 1.20 

centímetros. Finalmente, para las coordenadas se obtuvo, en promedio, que la ubicación del 

frente de grieta ya propagada quedaba en la coordenada 27.87, medido en centímetros, con 

respecto al largo de la viga, mientras que, con respecto al alto, el promedio de coordenadas 

quedó en 3.83 centímetros. A continuación, se pueden ver las gráficas en la ilustración 76 y 

77 obtenidas con respecto a la propagación de la grieta para cada muestra y su respectiva 

variación de coordenadas en cada eje.  

 

Ilustración 76 Gráfica experimental de la propagación de la grieta viga IPE 100. [Elaboración propia]. 
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Ilustración 77 Ubicación en el plano de la propagación de la grieta experimental en viga IPE 100. [Elaboración propia]. 

4.1.3 Análisis comparativo de resultados entre muestras IPE 120 – IPE 100 

Se realiza una comparación entre la media de la propagación de las grietas obtenidas 

mediante el ensayo a flexión para cada tipo de muestra, de acuerdo con sus dimensiones, para 

identificar el comportamiento de las grietas en ambas vigas ensayadas.   
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Ilustración 78 Promedio de propagación de las grietas en ensayo experimental. [Elaboración propia]. 
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Se puede apreciar que existe una propagación mayor en la viga IPE 120 con 1.23 cm 

comparado con la viga IPE 100 con 1.20 cm. El acero con geometría más grande muestra 

una mayor propagación de grieta. Cabe destacar que la muestra con mayor propagación 

también es a la que mayor carga se le debe aplicar para generar dicha propagación, como se 

puede verificar en la siguiente ilustración.  

 

 

 

 

 

 

 

 

Adicionalmente, se realiza la gráfica de comparación con respecto al frente de grieta después 

de la propagación experimental, visualizada en la ilustración 80. Se puede apreciar que ambos 

frentes se encuentran distanciados milimétricamente, independiente de su composición 

geométrica, existiendo una diferencia más grande en la altura de propagación que hacía las 

otras direcciones.  

 

 

Ilustración 79 Gráfico de aplicación de carga promedio para propagación de carga en ambos tipos de viga. 

[Elaboración propia]. 

Ilustración 80 Ubicación promedio frente de grieta propagado para cada viga. [Elaboración propia]. 
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4.2 Análisis de resultados en ensayos a flexión en Salomé-Meca 

Los ensayos a flexión se realizaron con varias iteraciones para cada tipo de muestra, haciendo 

variar la longitud de la grieta permitida para un número de paso de carga constante. Esta 

variación generaba las diversas propagaciones en las muestras. Los parámetros de la ley de 

Paris se mantuvieron constantes para todas las simulaciones con valores de C = 3.8x10-12 y 

M = 3 para acero A36. La carga aplicada para cada tipo de viga fue la obtenida 

experimentalmente en el laboratorio, para ambos tipos de vigas constantes.  

4.2.1 Simulación de viga IPE 120 

A continuación, se muestran los resultados para la simulación de las muestras de tipo IPE 

120 con distintos tamaños de elementos en la misma malla.  

• Para mallado de 50 mm 

Tabla 6 Resultados de la simulación para viga IPE 120 con mallado de 50 mm. [Elaboración propia]. 

• Para mallado de 25 mm 

Tabla 7 Resultados de la simulación para viga IPE 120 con mallado de 25 mm. [Elaboración propia]. 

 

 

Longitud de avance de la grieta (mm) Propagación (mm) Coordenada final en X (mm) Coordenada final en Z (mm)

3.0 11.44 277.59 23.85

3.2 11.52 277.93 24.13

3.4 11.89 278.08 24.06

3.6 11.94 278.57 24.62

3.8 11.72 279.02 25.15

4.0 11.57 279.39 25.49

4.2 11.93 279.00 27.00

4.4 12.04 280.41 26.62

4.8 12.23 280.78 27.11

4.9 12.30 280.95 27.32

5.0 12.62 281.12 27.32

IPE 120 MALLA 50 mm

Longitud de avance de la grieta (mm) Propagación (mm) Coordenada final en x (mm) Coordenada final en Z (mm)

5.0 11.39 280.30 28.71

5.2 11.46 280.75 29.62

5.4 11.62 281.30 30.72

5.6 11.80 281.50 31.72

5.8 12.27 281.95 31.85

5.9 12.49 282.10 32.12

6.0 12.63 282.22 32.37

IPE 120 MALLA 25 mm
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• Para mallado de 12.5 mm 

Tabla 8 Resultados de la simulación para viga IPE 120 con mallado de 12.5 mm. [Elaboración propia]. 

• Para mallado de 10 mm 

 

• Para mallado de 5 mm 

 

En las tablas de resultados recién presentadas, se analizan las iteraciones realizadas gracias a 

la variación de la longitud de avance de la grieta para los números de carga asociados a las 

simulaciones en el software de las vigas IPE 120. Si bien la propagación de la grieta se 

alcanza en cada uno de ellos, la longitud de avance declarada es distinta para cada probeta, 

como se puede apreciar en la ilustración 81. A medida que la dimensión de la malla se hace 

más pequeña, la longitud de avance tiende a converger en un valor cercano a 6.1. 

Simultáneamente, las coordenadas del frente de grieta después de la simulación también 

sufrieron variaciones.  

Longitud de avance de la grieta (mm) Propagación (mm) Coordenada final en X (mm) Coordenada final en Z (mm)

5.0 10.10 283.13 35.40

5.2 10.52 283.04 36.03

5.4 10.93 283.18 36.41

5.6 11.33 283.63 36.45

5.8 11.73 284.06 36.49

6.0 12.13 284.19 36.89

6.1 12.33 284.42 36.88

6.2 12.52 284.65 36.49

IPE 120 MALLA 12.5 mm

Longitud de avance de la grieta (mm) Propagación (mm) Coordenada final en X (mm) Coordenada final en Z (mm)

5.0 10.14 278.13 38.38

5.2 10.54 278.05 38.15

5.4 10.94 277.98 37.97

5.6 11.68 277.95 37.83

5.8 11.75 277.92 37.62

6.0 12.15 277.90 37.39

6.1 12.35 277.86 37.22

6.2 12.55 277.84 37.03

IPE 120 MALLA 10 mm

Tabla 9 Resultados de la simulación para viga IPE 120 con mallado de 10 mm. [Elaboración propia]. 

Longitud de avance de la grieta (mm) Propagación (mm) Coordenada final en X (mm) Coordenada final en Z (mm)

5.0 10.00 279.66 38.21

5.2 10.40 279.82 38.02

5.4 10.80 279.89 37.87

5.6 11.20 279.96 37.69

5.8 11.60 279.97 37.43

6.0 12.00 280.01 37.24

6.1 12.20 280.02 37.15

6.2 12.40 280.03 37.02

IPE 120 MALLA 5 mm

Tabla 10 Resultados de la simulación para viga IPE 120 con mallado de 5 mm. [Elaboración propia]. 
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Para la viga IPE 120 la propagación de la grieta en el ensayo experimental fue de 1.23 

centímetros, por lo que los resultados convergentes son los siguientes:  

 

Para validar los resultados de la tabla 11, se realiza el cálculo del error asociado al mallado; 

lo que se conoce como análisis de resultados, detallado en el capítulo anterior. Para realizar 

dicho cálculo se realiza una comparación con un resultado exacto, en este caso se verifica 

con respecto al ensayo del laboratorio, en la siguiente tabla se muestran los errores asociados.  

 

 

 

 

 

 

 

Ilustración 81 Convergencia del parámetro de variación de grieta y coordenadas en vigas IPE 120. [Elaboración propia]. 

Dimensión del mallado Long. de avance de la grieta (mm) Propagación (mm) Coord. Final en X (mm) Coord. Final en Z (mm)

Mallado 50 mm 4.9 12.30 280.95 27.32

Mallado 25 mm 5.8 12.27 281.95 31.85

Mallado 12.5 mm 6.1 12.33 284.42 36.88

Mallado 10 mm 6.1 12.35 277.86 37.22

Mallado 5 mm 6.1 12.20 280.02 37.15

Tabla 11 Resultados convergentes de la simulación en viga IPE 120. [Elaboración propia]. 

Tabla 12 Error aproximado del mallado para viga IPE 120. [Elaboración propia]. 

Tipo de mallado Error coord. Final en X (%) Error coord. Final en Z (%)

Mallado 50 mm 1.06 25.55

Mallado 25 mm 1.42 13.22

Mallado 12.5 mm 2.31 0.49

Mallado 10 mm 0.05 1.42

Mallado 5 mm 0.73 1.23
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Por lo visualizado en la tabla 12, los resultados obtenidos en la simulación a medida que se 

va asignando una malla más pequeña tienden a converger con respecto a los resultados 

experimentales, es decir, se alcanza la longitud de la grieta propagada en el laboratorio, y se 

encuentran aproximadamente las coordenadas de ubicación del nuevo frente de grieta, con 

un error de 0,73% y 1,23% (Ver ilustración 82), para las coordenadas de largo y alto de la 

viga respectivamente en la malla de tamaño máximo de 5 mm, valor que es pequeño para 

comparaciones computaciones y experimentales, por lo que se aceptan los resultados para la 

simulación de la viga IPE 120.  

4.2.2 Simulación de viga IPE 100 

• Para mallado de 50 mm 

Longitud de avance de la grieta (mm) Propagación (mm) Coordenada final en X (mm) Coordenada final en Z (mm)

3.80 11.28 276.46 28.36

4.00 11.40 276.76 28.78

4.20 11.66 276.93 28.60

4.40 11.82 277.20 28.90

4.60 11.99 277.52 29.36

4.80 12.22 277.72 29.31

4.90 12.31 277.89 29.58

5.00 12.40 278.06 29.83

Tabla 13 Resultados de la simulación para viga IPE 100 con mallado de 50 mm. [Elaboración propia]. 

Ilustración 82 Disminución del error asociado a malla en viga IPE 120. [Elaboración propia]. 
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• Para mallado de 25 mm 

• Para mallado de 12.5 mm 

• Para mallado de 10 mm 

 

• Para mallado de 5 mm 

 

Longitud de avance de la grieta (mm) Propagación (mm) Coordenada final en x (mm) Coordenada final en Z (mm)

5.00 11.21 276.27 32.38

5.20 11.48 276.43 32.61

5.40 11.63 276.64 33.04

5.60 11.81 276.72 33.46

5.80 11.96 276.80 33.80

5.90 12.05 276.93 34.14

6.00 12.26 277.02 34.52

IPE 100 MALLA 25 mm

Tabla 14 Resultados de la simulación para viga IPE 100 con mallado de 25 mm. [Elaboración propia]. 

Longitud de avance de la grieta (mm) Propagación (mm) Coordenada final en X (mm) Coordenada final en Z (mm)

5.00 10.35 276.24 36.98

5.20 10.68 276.21 36.47

5.40 11.07 276.13 36.84

5.60 11.49 276.31 37.38

5.80 11.84 276.44 37.89

5.90 12.04 276.51 38.13

6.00 12.23 276.60 38.36

6.10 12.32 276.71 38.52

6.20 12.60 276.82 38.88

IPE 100 MALLA 12.5 mm

Tabla 15 Resultados de la simulación para viga IPE 100 con mallado de 12.5 mm. [Elaboración propia]. 

Longitud de avance de la grieta (mm) Propagación (mm) Coordenada final en X (mm) Coordenada final en Z (mm)

5.0 10.16 279.04 37.12

5.2 10.63 278.97 37.51

5.4 10.99 278.88 37.89

5.6 11.41 278.81 38.28

5.8 11.74 278.76 38.66

5.9 12.04 278.74 38.86

6.0 12.13 278.72 39.05

IPE 100 MALLA 10 mm

Tabla 16 Resultados de la simulación para viga IPE 100 con mallado de 10 mm. [Elaboración propia]. 

Longitud de avance de la grieta (mm) Propagación (mm) Coordenada final en X (mm) Coordenada final en Z (mm)

5.0 10.41 280.20 36.84

5.2 10.62 280.32 37.23

5.4 10.82 280.43 37.64

5.6 11.21 280.54 38.04

5.8 11.61 280.57 38.43

5.9 11.81 280.51 38.63

6.0 12.00 280.13 38.81

6.1 12.20 279.82 38.98

IPE 100 MALLA 5 mm

Tabla 17 Resultados de la simulación para viga IPE 100 con mallado de 5 mm. [Elaboración propia]. 
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En las tablas de resultados anteriores se analizan las iteraciones realizadas producto de la 

variación de la longitud de avance de la grieta en el programa computacional para las vigas 

IPE 100. La propagación de la grieta se alcanza en cada uno de ellos, pero la longitud de 

avance declarada es distinta para cada probeta, como se puede apreciar en la ilustración 83.  

 

 

 

 

 

 

 

 

 

 

 

 

A medida que la dimensión del mallado se hace más pequeña, la longitud de avance tiende a 

converger en un valor cercano a 6, de modo similar a las simulaciones de la viga IPE 120. 

Mientras tanto, las coordenadas del frente de grieta después de la simulación varían 

dependiendo de la longitud de la malla. Con respecto a la viga IPE 100 la propagación de la 

grieta en el ensayo experimental fue de 1.20 centímetros, por lo que los resultados 

convergentes son los siguientes:  

 

Finalmente, para validar los resultados de la tabla 18 se procede a calcular el error asociado 

al mallado, es decir, qué tan cercano se encuentran las simulaciones con respecto a la 

experimentación del laboratorio. En la siguiente tabla se muestran los errores asociados.  

 

Ilustración 83 Convergencia del parámetro de variación de grieta y coordenadas en vigas IPE 100. [Elaboración propia]. 

Long. de avance de la grieta (mm) Propagación (mm) Coord. Final en X (mm) Coord. Final en Z (mm)

4.6 11.99 277.52 29.36

5.8 11.96 276.80 33.80

5.9 12.04 276.51 38.13

5.9 12.04 278.74 38.86

6.0 12.00 280.13 38.81

Tabla 18 Resultados convergentes de la simulación de la viga IPE 100. [Elaboración propia]. 
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Según la tabla 19 y al igual que en la simulación de la viga IPE 120, a medida que se va 

asignando un mallado con dimensiones más pequeñas, es decir, aumentan la cantidad de 

nodos y elementos. Por ello, se realiza un cálculo con mayor discretización, dándose que los 

resultados que arroja el software tienden a converger con los experimentales. 

Adicionalmente, las coordenadas geométricas del frente de grieta poseen un error asociado a 

la coordenada del largo de la viga de 0.51% y el asociado a la altura es de 1.33% en la malla 

de tamaño máximo 5 mm, valores que son pequeños para verificaciones computacionales y 

experimentales, por lo tanto, se aceptan los resultados de la simulación de la viga IPE 100.  

 

En la ilustración 85 se puede apreciar la comparación entre la muestra IPE 100 ensayada en 

el laboratorio y el modelo simulado en Salomé-Meca con mallado de 12.5 mm. Mientras que 

en la ilustración 86, se puede apreciar la misma comparación para la muestra IPE 120. 

Ilustración 84 Disminución del error asociado a malla en viga IPE 100. [Elaboración propia]. 

Tipo de mallado Error coord. Final en X (%) Error coord. Final en Z (%)

Mallado 50 mm 0.42 23.34

Mallado 25 mm 0.68 11.75

Mallado 12.5 mm 0.79 0.44

Mallado 10 mm 0.01 1.46

Mallado 5 mm 0.51 1.33

Tabla 19 Error aproximado del mallado para viga IPE 100. [Elaboración propia]. 
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Ilustración 85 Verificación de la muestra IPE 100 experimental con muestra IPE 100 simulada con malla de 

12.5 mm. [Elaboración propia]. 

Ilustración 86 Verificación de la muestra IPE 120 experimental con la muestra IPE 120 simulada con malla de 12.5 mm. 

[Elaboración propia]. 
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CAPÍTULO 5: CONCLUSIONES Y RECOMENDACIONES 

 

Esta investigación se centró en el estudio de propagación de grietas de forma experimental 

en vigas de acero comercial, tipos IPE 120 y IPE 100 de forma dog-bone. Se les indujo una 

grieta en el centro, con un esmeril angular, con un ángulo de inclinación de 33.55° respecto 

al plano horizontal. Adicionalmente, se simuló la propagación de la fisura en el software de 

elementos finitos Salomé-Meca, con condiciones geométricas y propiedades constitutivas 

idénticas a las muestras experimentales. Al realizar la comparación de resultados de ambos 

procedimientos se lograron validar los resultados entre sí, puesto que las propagaciones de 

las grietas y la ubicación de los nuevos frentes de grieta en los dos estudios son muy similares 

para ambos tipos de muestras. Esta validación permite considerar este análisis computacional 

para estudiar elementos estructurales, verificando su tolerancia al daño y el comportamiento 

en el tiempo de las grietas y las irregularidades del material.  

En la experimentación a flexión en el laboratorio, en todas las muestras se alcanzó una 

propagación de la grieta, encontrando nuevas coordenadas para el frente de grieta después de 

la aplicación de la carga. Al tener una propagación de la grieta, se aceptan los modelos 

comerciales seleccionados para realizar la experimentación. Por otra parte, se produce una 

deformación en el centro de la viga acorde a la aplicación de las cargas por flexión en forma 

gravitacional. Adicionalmente, se produce un fenómeno secundario de inestabilidad elástica 

en la zona debilitada por el dog-bone. Este fenómeno se llama pandeo.  

Con respecto a la simulación en Salomé-Meca, se realizó un estudio con materiales y 

propiedades de carácter lineal. El análisis realizado fue de tipo mecánico estático lineal, que 

se realizan comúnmente a las estructuras. Se logró propagar la fisura inducida en el modelo 

simulado, encontrando nuevas coordenadas para el frente de la grieta cargada virtualmente, 

por lo que se acepta el software como herramienta de análisis de propagación de grietas y 

estudio de fatiga en elementos estructurales.  

Por otra parte, al estudiar un problema de métodos de elementos finitos, hay que realizar un 

análisis de resultados sobre las simulaciones generadas por los diferentes tamaños de mallas 

asignadas, ya que a mayor cantidad de nodos y elementos, el error asociado a las mallas va 

disminuyendo, acercándose a los resultados reales. Sin perjuicio de lo indicado 

anteriormente, no necesariamente el asignar más nodos y elementos mejorará 

considerablemente los resultados, si no que puede causar una sobrecarga computacional, 

haciendo más lentas las iteraciones. Para esta investigación se asignaron a ambos modelos 

un mallado de 50 mm, de 25 mm, de 12.5 mm, de 10 mm y de 5 mm. Si bien en el primero 

se presenta un porcentaje de error en la coordenada de altura considerable, a medida que se 

iban utilizando las mallas de longitudes más pequeñas, este fue disminuyendo 

progresivamente, logrando visualizar el proceso de disminución del error de mallado a través 

de la simulación de ambos modelos, de modo que se aceptan los 5 tipos de tamaños de 

elementos para la malla asociadas al ensayo virtual.  
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Por otro lado, al realizar la experimentación surgió un efecto secundario que se mencionó 

anteriormente y que no se encontraba dentro de los objetivos planteados, como fue el pandeo. 

Este es un efecto que surge cuando la viga se comienza a plastificar. De la misma forma, la 

simulación en el software fue de carácter lineal, a pesar de que se intentó estudiar la 

plastificación con un análisis no lineal. No se encontró una ley que pudiese modelar 

adecuadamente el fenómeno, por lo que no se logró reproducir el efecto de plastificación en 

la experimentación y se decidió por continuar con el estudio lineal, atendiéndose el objetivo 

principal de la investigación.  

Es por esto, que se aconseja para futuras investigaciones el estudio de leyes de plastificación 

de material que puedan originar el pandeo, a fin de poder programar a través de los comandos 

de Python o a través de la interfaz de Aster Study el efecto deseado y verificar su 

comportamiento con respecto a lo observado en el laboratorio. 

Adicionalmente, se recomienda, para no evidenciar el efecto de plastificación en las probetas 

elegidas, considerar elementos menos esbeltos para evitar que se genere una inestabilidad 

elástica del material.  
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